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1 Introduction
Dartfish software provides advanced video tools to enhance your training programs and improve
athletic performance. The system works both during workout and afterward when time allows
for a more in-depth analysis of a performance.

During the workout

Using Dartfish InTheAction*, you will be able to provide instant visual feedback to your athletes.
This feedback will supplement your personal coaching and allow you to maximize the benefits of
using the muscle memory (proprioceptive) of your athletes and students. Thanks to a wide
variety of customizable play modes, the use of video can be fully integrated into your usual
activities with athletes on the field.

After the workout

Dartfish software's set of video analysis features allow you to create new perspectives and
innovative views of your athletes' performances:

 You are able to compare and view performances as never before to highlight areas needing
improvement.

You can annotate video with text and drawings to aid and communicate analysis

Dartfish's video management system helps you manage all your training videos with ease and
efficiency.

Share your analysis 

 You can share your analysis with anyone, anywhere to continue the communication and learning
experience. You can send video clips via e-mail, create enhanced CD/DVDs or even publish
interactive analysis on the Internet.

Make sense of competition footage

Tagging* is Dartfish's notational analysis tool.  Use it to create a descriptive index of the key
events in a game or other long video.  Tagging has tools to turn your index into a focussed team
feedback presentation and also display frequency statistics of each event.  Tags are created by
clicking a set of fully customizable buttons, or by import from your sports own statistical tools,
or even from the Dartfish Easytag app for iPhone or iPad, available from the Apple App Store.

Display data on video

For those working quantitatively, measurements of time, distance and angle can be made on
video and recorded in a Data Table. The Data Table can even record changes in measurement or
changes in position of tracked* objects.

Using the Data Reader add-ons*, you can import data from any device or software that can
create a CSV (character separated value) file and relate the output to what the video shows.

Dartfish is also capable of simultaneously recording video and data using InTheAction* . This
allows data to be displayed or graphed on video immediately after capture.  Dartfish has
developed links to several force platforms but also makes its SDK (software developer kit)
available to you to develop your own links.

Use Dartfish special effects for unique analysis opportunities

Strom otion* and Sim ulcam* are tools used by sports broadcasters world-wide to analyze and
explain movement to their audience.  Users of Dartfish can also benefit from these tools. 
Simulcam is the only way to get a realistic comparison of video  when the camcorder is panning.
Stromotion and ball tails* give an understanding of how performers and objects move from one
position to another. 

*Asterisked features are not available in all Dartfish editions
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1.1 Support and help to use your software

This manual provides help to learn the range of Dartfish software features but it isn't the only
source of help available to you. 

Start with the video demonstrations on the Start page, which guide you through getting started
with the basic features. Then, increase your understanding by reading these help chapters or
using the more comprehensive video based tutorials available online.

The Dartfish Customer Care Portal

In addition to this help, a wide range of support is available to you and the easiest way to access
all of this is by following the links on the Start Page of your Dartfish software. This is your
gateway to: 

T raining Resources:  Learn at your own pace with tutorials, comprehensive guides, instructor-led
online seminars or arrange tailored training courses.

Technical Support: Search the Dartfish knowledge base and find answers to your questions or
contact our experienced team directly.

Download Section: Get your products, updates, drivers and release notes online. 

Product Inform ation: Get an overview of your previously registered products, retrieve your
license key at any time or register another product.

An alternative way to access the Customer Care Portal is to use your Browser to take
you to http://support.dartfish.com

Registering your software

Your first step in getting support is to register your software because the possibilities available to
you vary according to the support package supplied with your software.  In the case where you
have multiple users of the same software, each user can register and create their own login
because the support package is linked to the software and not to its users.

Note that registering your software is not the same as providing the licence key during
installation or activating it after installation.  Registration is the process that identifies you as a
user of your software and it is highly recommended that all users should register in order to
benefit from Dartfish support.

Talk to us

Dartfish has evolved and developed thanks to a continuous dialogue with users, we look forward
to your comments and suggestions to help enhance future versions. Our continuing goal is to
make every software release better to fit the needs of our users.  
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2 Getting familiar with Dartfish
Whether you are new to Dartfish or looking to improve your knowledge, this chapter is essential
reading. It covers all the basic information and skills that you will need in order to be able to use
Dartfish effectively.

You will become familiar with 
 

The Dartfish workspace and the Start Page
 

Video playback
 

The basics of the Video Library
 

Saving projects and videos
 

Sharing video clips between Dartfish's different modules and with other athletes or coaches.
 

Remote controlling Dartfish software.

After "getting familiar with Dartfish" you will be well on your way to using the broad range of
analysis, instructional and video sharing features that comprise this complete Sports coaching
tool.

2.1 The Dartfish workspace

Dartfish workspace is designed so you can navigate through the video analysis and sharing
processes easily. Following, is an illustration of the Dartfish workspace.
 

 

1. The Menu bar to access different Dartfish views and functions. Click a menu at the top of the
program window to see the related menu commands.
 

2. The T oolbar buttons control what appears on the workspace such as the library and each
module (e.g. Analyzer)
 

3. The L ibrary allows you to manage, locate and share video clips and Dartfish projects.  The
library includes:

 

the Folder View and Keyword View (on the left) to locate the files.
 

the Item s List (on the right) which lists the located files. 
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the T ray (at the bottom) is a working area for storing video clips that you want to work

with.
 

4. The Module window is to carry out your tasks such as video capture, replay, comparison and
drawings.

Context menus are also available throughout the program. Place the mouse pointer in the
pane in which you want to work. Press the right mouse button, and select a command from the
menu.

2.1.1 The Start Page

The first time you launch Dartfish, the workspace is occupied by the Start Page.
 

 

The Start Page is divided into 4 areas:
 

1. Continue last session - click on Continue to continue your last work session (this link will not
show the very fist time you launch the software). 

 

2. Start a new task - use these links to configure the workspace for the selected task.
 

3. Getting started tutorials - click on a link to launch a video tutorial to help you get started
with a specific task.

 

4. Access to custom er care - the start page is the best route to getting the training and support
available to you. By using these links, information about your software and your support
history are automatically communicated to the support team, allowing them to  best advise
you. Links to tutorials and training take you to where you can access free training or arrange
for a local instructor to contact you.

 

Check for updates
 

The Dartfish team is constantly working to improve the software and many of the updates are
free.  Information found here will advise you when a new update is available.
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Closing the Start Page
 

If you wish, you can disable the Start Page when you launch your Dartfish software by
"unchecking" Always display the Start Page at startup which is at the bottom left hand side of
the Start Page. 
 

It is possible to re-start the Start Page at any time by selecting Tools > Start Page in the M enu
bar. The Start Page is closed by selecting any other Dartfish module from the Toolbar or Tools
m enu.

2.1.2 Displaying Dartfish Modules

Dartfish is composed of M odules - each with individual functions for analysis, instruction, sharing
etc.  A module is displayed in two ways:

1. by clicking the appropriate Toolbar button. 
 

2. by selecting the module from the Tools menu in the M enu bar

You do not need to close a module to open a new one - clicking on a module button
automatically replaces the old one with your selection. Only the Library can be simultaneously
displayed next to a module.

The core modules are listed below. More modules can be available based on the Dartfish
software edition you purchased. Read the relevant help chapters to learn how to use them.
 

 Im porter  - import video files from a range of video devices and drives.
 

 Player -  playback and trimming of video clips
 

 Analyzer - comparison of clips, drawing tools, key position analysis and publishing.

2.1.3 The Library

The Library allows you to locate, load, manage and share video clips.  It is displayed and hidden
using the Library button on Dartfish's toolbar.
 

F8 keyboard shortcut - closes/opens the library; it has the same function as clicking the library
button.

 

The library module is shown below with its four main parts labeled:
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1. The Library Toolbar contains buttons used to control the appearance and content of the
Item s List.

 

2. The Keywords View is used to locate video clips matching categories and values selected (see
link).  When this area displays its Folders View, the content of selected windows folders will be
displayed in the Item s List.

 

3. The Item s List is a list of video, image and project files that can be used by Dartfish.
 

4. The T ray is a working area for storing video clips that you want to work with. It is used to
share video clips between Dartfish modules and also share by email, CD ROM and Internet.

2.1.4 Resizing windows

You can resize windows in the workspace as follows: 

1. Place your cursor near the boundary between two windows.  
 

2. Once the cursor changes into a bar with two small arrows on either side, click and hold down
the left button of your mouse. Then you can move the cursor until the window is at your
desired size.  

The windows can be resized both vertically or horizontally.
 

When you close the software, the new layout is saved.

2.2 Video playback

The ability to control playback (play, pause, play frame-by-frame, modifying playback speed,
etc.) is one of the simplest benefits of using video analysis software.

To visualize a video clip, first open it by:
 



10 Dartfish User Guide

© Dartfish. All rights reserved. - Version 7 -

Double clicking the corresponding file name in the Item s List of the Library OR
 

Drag & drop your chosen clip onto the video panel of the module.

2.2.1 The Timeline

The T im eline is a visual representation of the video clip(s) currently loaded in a module.
 

 

The overall length of the video clip is represented by the bar along the bottom of the T im eline.
The part of the clip that will actually play is represented by the pale blue area between the cue in

point (  ) and the cue out point (  ).  The current playing position (the Playhead) is marked by

. The image displayed in a module screen corresponds to the playhead's current position.

2.2.2 Trimming video clips

Trimming video clips, that is setting new cue in/out points, is often necessary.  Perhaps because
unnecessary footage has been captured at the start or end of the clip.  Perhaps because you can
analyze or coach more effectively if the clip is shortened to show only specific actions.

Setting cue in/out points
 

1. Point the mouse at the cue in/out marker (  /  ).

2. Click and drag to the chosen start/end point.  The video display will show the selected start/
end frame as you drag.  

3. Release the mouse button.

 
You can also position the Playhead in the timeline, then click the cue in/out buttons found to the
left of the timeline.
 

Saving the trimmed video

Once the new in and out points are set, you have the choice of saving the trimmed video clip as
a new file (see Saving a new video to learn how to do this).

 Reset cue in/out points
 

1. Right-click on either the cue in/out markers or the Playhead.

2. Select Reset in/out Points from the context menu
 

 

You can also select Control>Reset user's in/out values from the M enu bar.
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2.2.3 Video panel controls

All the different modules have some control over how video is played. The video panel controls
for the Player module are shown below.  Most modules will have some of these features
although not all controls will always be available according to that module's specific needs.

 

The buttons have the following functions (from left to right):
 

Play/pause - becomes a pause button when the video is playing (keyboard shortcut: Space

bar)
 

Stop - also returns to the start of the clip ([Shift] + S)
 

Step previous - back one frame ([Ctrl] + [left arrow])
 

Step next ([Ctrl] + [right arrow])
 

Previous clip - play the previous clip in the T ray ([Ctrl] + P).
 

Next clip ([Ctrl] + N).
 

Hit F11 on your keyboard to display the video in full screen. Use the keyboard shortcuts listed
above to control the video playback.

 

Controlling speed
 

A wide variety of playback speeds can be selected using the speed control, shown below.
 

 

Clicking a number will position the speed cursor accordingly (e.g. 0.5). You can also click and
drag the cursor to select a precise speed (e.g. 0.35 as illustrated above).

 

Moving the Playhead
 

You can directly move the Playhead to a new position.  To do this:
 

1. Stop or pause the video, if it is playing.
 

2. Click anywhere in the pale blue area of the T im eline (or click and drag the Playhead left or
right).

2.2.4 Repeat mode

What do you want to happen when the clip(s) you have loaded finish playing?  The Repeat button
found in many Dartfish modules )located on the left of the speed control) offers a number of
choices as shown below.
 

 Play current clip once.

 Repeat current clip.

 Play all (clips loaded into the tray) once.

 Play all  then repeat.
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To change the repeat mode
 

Click the repeat mode button.  Each time it is clicked, the mode (and the button icon) will
change.
 

The tooltip (the yellow box which appears when you point your mouse at a button or control)
shows both the mode that will be activated when the repeat mode button is clicked and the
current mode in parenthesis.

2.3 Saving projects and videos

When working with many Dartfish modules you will have the choice of saving a "project" or
saving the video file resulting from the project.  

 

Saving a project
 

When you save a project you are saving all the information that relates to the creation of that
project; the video files used, the settings chosen etc. Generally you will save projects if you wish
to make changes to the project to get a better result or because you wish to base a new project
on the settings used previously.   

It is important to note that projects do not actually include the video files used by the project.
For example, saving a project using two 5Mb video clips will not end up in a project file
somewhere over 10Mb.  It also means that if sharing projects with other Dartfish users, you will
also need to give them the video files used by that project.

 

Saving a video clip
 

When you save a video clip you are creating a new video file that can be used by other Dartfish
modules or shared with others - even those who do not have the Dartfish software will be able
to play back video clips on their own computers.

2.3.1 Saving a project

Select F ile>Save (or F ile>Save As...) from the M enu bar to save a project. The type of project
(and project file icon) depends on the module currently in use when saving:
 

 - Analyzer project  
 

 - SimulCam project 
 

 - StroMotion project 

If a project is saved in a M onitored folder of your Library (see section Defining your library in
the Library chapter), it will be displayed in the Item s List.

If you did not save a project when changing modules, you will be prompted to do so. Select
Yes to save a project.
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To open a saved project
 

Double-click on the project icon in the Item s List
 

Select F ile>Open from the M enu Bar.

 

To start a new project
 

Select F ile>New from the M enu Bar. If you did not save the current project, you will be prompted
to do so (see above). Starting a new project will also empty the Storyboard of the Analyzer.

2.3.2 Saving a new video

Select F ile>Save M ovie... from the M enu bar to save a new video. A wizard will guide you
through the saving steps. Different wizards are shown based on the module currently opened.

 

Video Trimming Wizard
 

The Video Trimming Wizard will launch when the Player module is open.  Complete the wizard to
save a trimmed version of the clip currently loaded in the Player (see Trimming video clips to
learn how to set the cue in/out values). 

There are two options:
 

Replace the original video clip by the trim m ed video clip - Used to delete unnecessary  footage
at the beginning and end of a captured clip.
 

Create new video clip into the following folder - Used to extract video clips from a longer
footage.

 

Video Saving Wizard
 

The Video Saving Wizard will launch when the Analyzer module is open. Complete the wizard to
save a montage of the analysis contained in the Storyboard (read the chapter on the Analyzer).
The main steps of the wizard are:
 

1. Selecting the video settings (see Converting video)
 

2. Entering the file information, i.e. a file name and the category/values to classify the new video
(see Organizing your library to learn more about the file name and categories)

 

3. Selecting the destination folder
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2.4 Sharing video files

Dartfish offers many ways of sharing videos with athletes or other coaches. The Video Sharing
W izard guides you through the process of selecting and compressing video before exporting it to
the appropriate media.  The choices of sharing destination are:
 

M y Com puter - copy your video to a folder, to an external drive or to a network server.
 

Em ail - the video clip is compressed and attached to an email in your default email program

(see note below).
 

Recordable CD or DVD - burn video to CD or data DVD directly from Dartfish. 
 

Enhanced Recordable CD or DVD - creates a CD with an easy-to-use interface customized

with your branding and contact information.
 

Internet - send video to a FTP location.
 

Dartf ish TV - Dartfish's online media sharing platform.

 

The share by email option works for any MAPI email software such as MS Outlook or Outlook
Express.  For other email software or web-based email like Hotmail you will have to attach video
files through the software or website itself.

2.4.1 Video Sharing Wizard

Loading clips for sharing

 

The Video Sharing W izard is a feature of the T ray. Start by loading the video clips you wish to
share into the T ray. To do this, drag-and-drop video files from the Item s List to the T ray. Hold
down the [Ctrl] key while clicking on the files to select multiple files.
 

 

Once video clips are loaded, click the tray's Share button.

 

The Video Sharing Wizard

 

The process of sharing is guided by the Video Sharing W izard.  Three steps are common to all
sharing destinations.

 
1. Selecting the sharing Destination - Click on a destination then on the Next> button (at the

bottom of the window) to proceed.
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2. Selecting which videos you wish to share.  "Check" those to be shared as shown below or
click the Select All button:

 

 

3. Choose the video settings (encoding profile) appropriate for the selected destination (see
Video settings for information on the different encoding profiles).

Specific additional information may be entered according to the selected destination. Read the
information displayed in the wizard to complete these information (also see the Outputs from
Dartfish - Publishing & Sharing chapter).

2.4.2 Converting video

When sharing or storing video, there are two important considerations:

F ile Size: video file sizes can be very large which can be a problem when storage space or the
distribution method have limited capacity.

Video stream ing: unless video files will be played from a local drive there are likely to be limits on
the rate at which data can be streamed. The amount of video data streamed per second is
expressed as its bit rate.  Most obviously, video played from the internet needs to have a lower
bit rate than that produced by a typical video camcorder.  Networks and optical drives also
impose limits on the maximum bit rate of video which can be played from them.

These considerations are addressed by compressing video by means of encoding and any
Dartfish process which results in the creation of new video offers a range of suitable encoding
profiles.

About video encoding

The subject of video encoding is a difficult one involving many variables but to enable the best
choice for encoding video with Dartfish it is useful to have a basic understanding of the following:

Im age quality:  Compression results in a loss of image quality – for any video format, the
greater the compression the lower the image quality. Direct comparison between formats based
purely on bit-rate is difficult because more recent codecs such as Windows Media 9 and H.264
achieve greater compression (smaller file size and a lower bit rate) for the same perceived image
quality as older codecs such as MPEG-2 and AVI (DV).
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HD versus SD: High definition (HD) video images appear sharper than standard definition (SD)
because they have higher resolution (more pixels).  When Dartfish encodes video it almost
always retains the resolution of the source video; so when an encoding profile name refers to HD
or SD this is a reflection of the resulting bit-rate and perceived image quality and does not
indicate a change in resolution.

Intended use: This, more than any other factor, will influence the encoding profile chosen.  For
Dartfish analysis one of the Windows Media profiles is generally the best choice but if the video is
being created for playback on an iPhone or upload to Dartfish.tv, one of those specific profiles
might be used. If video is being created for use on the internet your web master may have a
preferred video format.

Encoding versus re-encoding: Dartfish processes such as Save M ovie (Player), Convert, Share
and Publish Events (tagging) re-encode the  source video using the selected profile.  Changing
the video format can result in a loss of quality, although this won't be noticeable unless repeated.
 This is not an issue for Dartfish processes which create new video; Save M ovie (Analyzer),
Sim ulcam /Strom otion, Analysis recorder.

Dartfish encoding profiles

A complete list of Dartfish encoding profiles, their bit rates and suggested use can be found in the
Options (Tools menu > Options > Encoding Prof iles).  The different formats available are
summarized below

Form at Intended use

Windows Media Windows media encoding offers a good quality to compression ratio
and is the preferred option for producing video from Dartfish when
the output will be played on a computer's media player or in Dartfish.

Windows media video can also be used for internet but your website
administrator may prefer another format.

Windows Media for
Analysis Recorder

Highly compressed and reduced frame rate WMV used by the
Dartfish Analysis Recorder to encode video (Pro and TeamPro
editions)

MPEG-2 MPEG-2 video is produced by many camcorders and is also the
encoding used for DVDs.

These profiles will be the preferred encoding for users who wish to
maintain a library of MPEG-2 video or who produce DVDs.

To carry out analysis tasks Dartfish needs to create an index for each
MPEG-2 file. Encoding by Dartfish creates the index but if the file is
moved or shared with other Dartfish users the index needs to
recreated, which delays access to the file.  This may be a reason for
some users to avoid MPEG-2.

MPEG-4 (H.264) The MPEG-4 encoding profiles are used to produce H.264 encoded
video for playback on mobile devices and YouTube.

AVI (DV) AVI (DV) is the video format created from camcorders using DV tape.
AVI (DV) is an old format which is less compressed than WMV or
MPEG and this encoding will be primarily used by tape camcorder
users who wish to maintain a library of DV video. 

Dartfish.tv encoding
profiles

Contributors to Dartfish.tv can download the encoding profiles used
to produce video for their channel. Use of these profiles offers the
possibility to create video which is already encoded, thereby speeding
up the publication process.

These profiles can be exported/imported to distribute within an
organization.

SWF (Flash) Flash encoding is only used by Dartfish to create video for Analyzer
Mediabooks.

Video Settings in the Sharing Wizard
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The Video Sharing Wizard includes a Video Settings step in which you can choose to share the
original video, or re-encode it.

 

 

 

Video Conversion Wizard
 

Existing Video files on your hard drive can be converted to a range of other video formats with
the Video Conversion W izard. The process is as follows:
 

1. Select files from the Item s List or from the T ray.  Multiple files can be selected by holding
down the ctrl key and clicking each file.

 

2. Point at one of the selected files and click the right hand mouse button
 

3. Select Convert from the context menu that appears.
 

The subsequent process of choosing file format and location is the same as that for saving new
movies but you are reminded to pay special attention to whether you want to replace the
existing file or create a new file with a different name.
 

2.5 Remote controlling Dartfish

Many of Dartfish's buttons and controls can be activated by remote control. This powerful option
allows you to record or present without the restriction of having to stand next to the the
computer. There are two types of remote control:

Streamzap remote and IR receiver

The Streamzap shipped with Pro and Live editions of Dartfish prior to Dartfish 6. It is still available
to purchase from your Dartfish reseller. It uses its own Infrared receiver and has a range or
around 25 meters.

Jumi wifi remote

Jumi is an app for iOS which allows the creation of custom remote controls which function on a
WiFi network. Its range is therefore only limited by network access but it requires the presence of
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a WiFi network which allows the communicatoin between the app and the computer.

2.5.1 Streamzap remote control

To install the remote control drivers:

1. Run the Dartfish software installation program and wait for the list of options to be displayed.

2. Choose Drivers from the list of choices

3. Choose Stream zap rem ote. You are guided through the process of installing the receiver.

4. Connect the receiver

When the receiver is connected for first time Windows will detect it and install the drivers for
that USB port.  Depending on your Windows setup this is a two step process: 
In the first step, Windows asks whether you want to go online to search for drivers.  The
answer to this is No, not this time.  Driver software is already available as part of the
Dartfish installation.
In the second step you are asked if you want to install manually or automatically.  The
answer is Automatic [Recommended].  This is the recommended and default option.

5. Windows should successfully install drivers software for the infra red receiver.

6. Now users of 64 bit Windows should download updated drivers and instructions from Dartfish
Customer Care.

 Trouble shooting installation
 

Look for the Dartfish Remote icon in the system tray area of the Windows taskbar:
 

If it is red:  The remote control is installed and functional.  Ensure that the receiver is
pointed towards the remote control, batteries are fresh, the receiver is within range and there
aren't other sources of infra red interference - the flashing red light on the receiver confirms
when an IR signal is received but not whether it is strong enough or from which source.

If it is grey:  The remote control software is installed but the IR receiver is not connected.  If
it is connected to a USB port the likelihood is that drivers are not installed for that USB port
correctly.  Try removing the receiver and connecting it to a different USB port.

If it is not present:  In a small number of cases the Streamzap software does not
automatically start after installation.  In this case you can force it to start by restarting the
computer or manually activating its executable file at /program files/Streamzap/Remote/
zremote.exe.

Using the Streamzap

The Streamzap remote controls many of the functions in different Dartfish modules. We
recommend that you become familiar with these buttons and how they can help you coach more
effectively. If this looks like too much to remember how about starting with the group of six
buttons under Play and Pause.  You can learn the rest as you find you need them.
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Now that you can use Dartfish remotely you should be able to display video in full screen. Type
[F11] or look for the Full Screen button at the top of the remote.

2.5.2 Jumi remote control

Jumi is a remote control for iOS for which Dartfish have created a customised remote control

 

PC Installation

1. Go to Dartfish Customer Care and download and extract WiFiRemoteControl.zip.

2. Run InstallJumi.exe and follow the on-screen instruction to install the controller software
(Jumi Controller’s icon should appear in the Windows system tray)

3. The first time Jumi Controller runs, you are required to supply a master password: any
password can be entered – the same password will later be used to connect your iPhone to
your PC.

4. Click Save to finalize the controller configuration.

5. Run Dartfish6_Remote.zip.JumiTAP.jumi. A ‘file imported successfully’ message should
appear confirming that Jumi is now customized for Dartfish.

iPhone/iPad installation

1. Download jumiremotes from the App Store.

2. Make sure your computer and your mobile device are connected to the same wireless
network

3. Launch the Jumi remotes app, you should see your PC listed
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4. If your PC is not found automatically, tap Add then enter the same IP addresses and port
number that are displayed by the Jumi Controller on your PC

5. Enter the master password you created previously, and select ‘Login’ or ‘Login & Save’ if you
want to save the password for future logins

Using the Jumi Remote control

The Jumi remote controls many of the functions in different Dartfish modules. We recommend
that you start by becoming familiar with the buttons that control replay and learn the rest as you
find you need them. The icon on each button matches those found in Dartfish.

2.6 The next steps

In this chapter, you learned the basics of Dartfish software.
 

Your next step is to learn how to get video from your digital camera onto your computer so that
you can experiment with your own video straight away.  Read the Capturing Video chapter.
 

You can learn more about how Dartfish can help you find relevant video files with the Organizing
your library chapter. It will explain in detail the advantages of using categories to classify and find
your video clips.



Chapter

III

Video Library
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3 Video Library
The Video Library is a complete set of features used to locate and manage the files you wish to
analyze or share:
 

The video library is "built" from the Windows folders containing those files that are relevant

for use with Dartfish.
 

Because you are likely to analyze many video files, Dartfish helps you locate relevant content

using a flexible video content management system called Keywords which allow you to
describe the content of video clips more comprehensively than relying on organizing video
into different Windows folders.

 

Dartfish uses a Library module which offers rapid access to your content as well as a variety

of tools to help you locate relevant video files.
 

The Library module has a powerful sharing feature called the T ray. It provides a workspace

containing files which are being worked with. This not only makes them readily accessible for
use in Dartfish but also allows you to both archive on CD/DVD and share its content by a
variety of media including email, Internet and CD ROM.

 

In this chapter you will learn how to:
 

Define your library. Learn how to include the content you wish to see in the Dartfish Library.
 

Organize your library using Dartfish's Keywords.
 

Locate video files using Dartfish's array of search tools.
 

Create Playlists from the contents of the library.
 

Share video files by email, CD/DVD or Internet.
 

Convert video clips
 

Correct video errors such as incorrect interlacing, aspect ratio or orientation.

3.1 Defining your library

The library is the collection of ALL the video files that you want to use with Dartfish. These files
can be stored on several folders on your hard drive. 
 

To define the library you must tell Dartfish which folders to monitor. Only the video clips found in
these folders will show in the Library module. The default monitored folder is the windows Videos
folder

 

To add the contents of a folder to the library
 

1. From the menu bar, select Tools > Options (or type F3)
 

2. Click on the Library option
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3. Click on the Add... button. A browser window will open.
 

4. Chose a folder and click on OK. The sub folders of this folder will also be included in the library.
 

5. Repeat steps 3 and 4 to add additional folders.
 

6. To remove a folder from the list, click the folder in the list and click on the Rem ove button.

3.2 The Library workspace

The Library module is your route to accessing the content of the library. It is displayed and hidden
using the Library button on Dartfish's toolbar.
 

 

The library module is shown below with its four main parts labeled:
 

 

1. The Library Toolbar contains buttons used to control the appearance and content of the
Item s List.

 

2. The Keywords view is used to filter the Item s List for video clips matching categories and
keywords selected. When this area displays its Folders view , the content of selected windows
folders will be displayed in the Item s List.

 

3. The Item s List is a list of video, image and project files that can be used by Dartfish.
 

4. The T ray contains thumbnails of recently created or opened videos.  Think of it as giving you
quick access to the files you are currently using.
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3.2.1 The Library Toolbar

The function of the Library Toolbar's buttons is to help you locate the items you wish to use from
the Item s List. These buttons have the following functions:

Keywords button - to display a list of categories and values by which the Item s List can be

filtered. To learn more about doing this see the topic Locating video files.
 

 

 Folders button - this displays a list of Windows folders. The Item s List will show the contents
of the folder selected from this list.
 

 

View Type button - to control how items are represented in the Item s List. Items can be

displayed in a simple list or showing details such as file size and category/values used. The
thumbnail views show an image of the first frame of video.

 

 

Back/forward navigation buttons - As different categories and folders are selected from the

Folders view or Categories view the Back and forward buttons become available to navigate
between them.

 

3.2.2 The Items List

The Item s List is a list of items that Dartfish is able to use. This includes video clips, images and
Dartfish projects, each represented by its own icon examples of which are shown below:
 

 - Video clips 

 - Picture files 

 - Analyzer projects  

 - SimulCam projects 

 - StroMotion projects 

 

File management using the Item s L ist
 

File management functions such as file renaming, deletion and copying can be carried out from
the Item s List. Display the range of options as follows:
 

1. Point the mouse at the item(s) you wish to edit.
 

2. Click the right mouse button. A context based "Quick menu" appears.
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3. Left click the function you wish to use.
 

The use of the Convert function is explained in the topic Converting video clips.

 

Opening video clips 

 

There are three methods of opening a video file from the Item s List:
 

1. Point at the item and double click the mouse.
 

2. Drag and drop the item from the Item s List on to the video display. This method offers more
flexibility when there is more than one video display to choose from.

 

3. Drag and drop the item onto the T ray section of the Library module. From here it can be
added to the video display as needed.

 

Opening Projects
 

Projects must be opened using the relevant Dartfish module. Either the appropriate module is
opened first or, if a project item is double clicked (method 1 above), the appropriate module will
start, closing the current module if necessary.
 
 

Opening Images
 

Image files can be opened by double clicking them however they will not be opened into Dartfish,
instead the default image viewing software on your computer will be used.

3.2.3 Item Properties

Further information about items can be revealed by using the Details view or the properties
window.

Details View
Details view is selected by clicking the View Type button on the Library Toolbar. The details view
reveals additional file and categorization information about each item as shown below.
 

 

These details can be exported as a CSV file see the topic Exporting keyword data.
 

The Properties window 
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To display an item's properties:
 

1. Point the mouse at the item.
 

2. Click the right mouse button. A context based "Quick menu" appears.
 

 

3. Select the Properties... option. The properties window appears for the selected item as
shown below.

 

 

Although much of the properties information is similar to that displayed in Details view, there are
two useful pieces of additional information:
 

File location - the folder on your hard drive where this file is located. The Open Containing

Folder button allows you to open this location to see other content of this folder.
 

Comment - comments can be edited in the properties window and can be used to provide

additional information about the file. This is particularly useful if you intend to share the file
(see Sharing video files) as your comments will form part of the content of an Enhanced CD.

The Properties window - source info tab

The properties window also shows information about the video source.  Some of these
properties can be modified to correct errors in the video.  See Correcting video property errors
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3.2.4 The Tray

The T ray is a working area for the collection of video files currently being used. It allows you rapid
access to files you want to analyze and provides a method for taking files from one module to
another. 
 

 

Additionally, organizing items into the T ray is the first step for:
 

Sharing video files (see Sharing video files).

Adding clips to the Tray

 Items will appear in the T ray when:

 Video clips are opened from the Item s List.

 New clips are captured from a video camera.

 Video clips are added by drag & drop from the Item s List.

 

Clearing the Tray
 

Selected items are removed from the T ray by clicking the Clear button.
 

 
 

If no files are selected the entire content of the T ray is cleared.

 

File management using the Tray
 

The items appearing in the T ray are a representation of the original file so unsurprisingly, the file
management functions available to items in the Item s List (see The Items List) are also available
to items in the T ray.
 

1. Point the mouse at the item(s) you wish to edit.
 

2. Click the right mouse button. A context based "Quick menu" appears.
 

 

3. Left click the function you wish to use.
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3.3 Organizing your library

Your Dartfish software includes a versatile video management system called Keywords. The
Keywords are used to describe the contents of your video clips in a simple and clear manner. For
example, you can define categories such as the name of the athlete, discipline, location of the
filming, assessment of performance etc and each video clip can be classified and easily located
by using Keywords in any or all of these categories.
 

Continuing this example, it becomes very easy to locate videos containing "John Smith" doing
"Bench press", "Incorrectly" and distinguish these from video of other athletes or even of "John
Smith" throwing the "Javelin".

3.3.1 Understanding Keywords

To understand the Keywords system, you must be able to distinguish between the following
elements:
 

The F ile Nam e that is defined for each video clip physically stored on your hard drive. A video

clip is identified with the icon illustrated below, with the file name displayed underneath (as
you can see in Windows Explorer).
 

  

The Keywords that represent the details of each clip. For example "Swing" and "Front" can be

used to describe a video clip containing a swing filmed from the front in golf. 
 

The process of classifying consists of assigning keywords to your video clips, i.e. labeling
them.

 

The Categories that group the Keywords of the same kind.
 

3.3.2 Defining your categories

To help you decide what categories and keywords you need, imagine you have several hundred
video clips on your computer. How would you label each one to identify it? When you look for
these video clips one year from now, what might you be looking for?
 

Perhaps you film different sports or different disciplines within a sport.  For this create a Sport

category or a Discipline category with values for each sport or discipline that you work with.
 

Perhaps you will want to compare video clips filmed from the same angle. That will be much

easier if you are able to distinguish clips filmed from the front and ignore those filmed from
the side. In this case, you may use the category Cam era Angle.
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So, what else might you look for? Age group perhaps if you want to compare athletes of a

similar age; An Assessm ent category if you want to be able to distinguish video where a skill
is performed well from where it is performed badly.

 

Once you have replied to these questions, you can create the nomenclature that will allow you to
classify and locate your video clips. 

3.3.3 Editing categories

To create a new Category
 

1. Click on the New button at the top of the library and select New category... from the menu
that appears.

 

 

2. Enter the name of your new category (e.g. Camera angle) and click OK.
 

 

The new category will appear in the Categories list.

To rename a category:
 

1. Right-click on a category label and select Edit... from the context menu
 

2. Type the new name and press the enter key on the keyboard.

To delete a category:
 

1. Click your mouse on a category to select it.

2. Click on the Delete category or value button in the category tool bar  .
 

3. Confirm the action by clicking OK. The category will disappear from the Categories list.
 

When a category is deleted all keywords within that category are also deleted. Video clips using
those keywords are not deleted but they will lose the deleted values.

3.3.4 Editing keywords

Keywords appear beneath the category headings. If needed, click on the arrow sign to the left of
a category to expand its list of corresponding keywords.  In the example below "Event" is the
category and "highjump", "javelin"... etc are the keywords used to describe the video clips.
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Creating, deleting and renaming keywords is done in the same way as for categories (see
Editing categories) except that you start by selecting  the category which contain the keyword.

3.3.5 Classifying video clips

Once your categories and keywords have been defined, you can classify your video clips. This
process consists of assigning keywords to your video clips, i.e. labeling them, in the same way as
you would label your suitcase to help you recognize it.
 

It is not just video clips that can be classified; any item that Dartfish lists in it's I tem s List can be
categorized to make it easier to locate.

 

To add a keyword to an item:
 

1. Select the item(s).
 

2. Drag the item on to the desired keyword.
 

Remember that you are not limited to adding a single keyword. You can repeat this process as
often as you like BUT only one keyword from each category can be added to each item.

You can classify several video clips at once. To do this, press on the Shift or Ctrl button on
your keyboard while left clicking with your mouse on the clips you wish to classify. Then drag and
drop the files to a keyword as described above.

 

To change the keyword attached to an item:
 

1. Select the item(s).
 

2. Drag the item to a different keyword within the same category.

It is often better to add keyword to your video clips as they are captured from your camera.
To find out how to do this, see the topic Setting Clip Properties

3.3.6 Removing keywords from video clips

As seen in the Editing categories topic, deleting a keyword from the categories list will also
remove that keyword from any items which hold it. However it is also possible to remove a
keyword from a video clip.

 

To remove a keyword
 

1. Click the View Type button at the top of the Library module
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2. Select Details.
 

3. Alter the width of the Item s List so that you are able to see the headings for each category
(these are only visible in Details or Thum bnail Details views). To do this you will click and
drag the right hand border of the Item s List.

 

4. Find the keyword you want to remove. To do this you may have to make the Item s List
wider still or use the scroll bar at the bottom of the Item s List.

 

5. Right click on the value and choose Renam e from the context menu. The keyword will enter
an editing mode as shown below:

 

 

6. Delete the existing keyword (Backspace key on your keyboard).

3.3.7 Importing/exporting keyword sets

The category and keyword information for each video clips is stored in a small extra M etadata file
(with a ".dartclip" file extension). Although this is not visible in Dartfish's I tem s List you can see it
using Windows Explorer as shown below.
 

 

When your video clips are shared, the recipient will also inherit a new set of categories and
keywords provided the metadata file was also shared. All Dartfish's sharing processes include
metadata.

 

What happens when inherited categories match existing categories?
 

Provided that the spelling and capitalization is identical, the new video clips will fit neatly into the
existing keyword system. But if, for example, the new video clip has a value of "Front View" and
you use a value "front view" then both keywords will now appear in your "View direction"
category.
 

When you and your fellow coaches will use the same categorization system (or you have more
than one computer) you can export a set of Category/keywords from one computer to another.

 

Exporting Categories/keywords

1. Click the Add a new category or keyword button .
 

2. Select the Export keyword set... option.
 

3. Save the export file.
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Make sure you know where the export file has been saved as it will be passed (by disk,
network or email) to the other coach or computer.

 

Importing Categories/keywords

1. Click the Add a new category or keyword button .
 

2. Select the Im port keyword set... option.
 

3. Locate and open the file to be imported. The new categories and keywords are now visible in
the Keywords view.

3.3.8 Exporting keyword data

Dartfish allows the export of the video library's keyword data in a CSV file that allows the data to
be stored and analyzed in databases and spreadsheets.
 

keywords associated with video files contain a lot of information that may be of more benefit
than assisting with finding and identifying the content of video files.  For example, specialist shoe
shops gather information about the shoes that customers buy as a result of video analysis;
researchers making observations from video may record that information using keywords.

 

To export Category/keyword data as a CSV file
 

1. Use the search and filter tools to isolate the video clips with data to be exported.
2. Point the mouse anywhere on the Item s List and click the right mouse button.
3. Choose Export List from the context menu that appears.
 

4. Save the CSV file.  It can be reopened by spreadsheet software such as MS Excel.

 

It is not necessary, but it may help, to change the library view to one of the details views.  This
will allow you to see what data is held for each file prior to export.  To do this:
 

1. Click the View button at the top of the library.
 

 

2. Select details or thum bnail details view.
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3.4 Locating video files

Dartfish's Library module offers three methods for helping you to locate specific video files from
the Item s List.
 

Keywords  view - displays a list of categories and keywords. The Item s List is filtered to

reflect files matching categories and keywords selected.
 

Search - the search box allows a text based search of filenames, categories and keywords of

the contents of the library.
 

Folders view - the typical way of locating files using MS Windows folders. The Item s List

displays the content of the selected folder.

3.4.1 Using Keywords

When using the Keywords system all video clips (and other Dartfish projects) in the Library will be
listed in the Item s List. That could amount to a lot of files!  You can filter the Item s List to show
only relevant clips by selecting the categories or keywords for those clips.

 

Filtering the Item s L ist by category
 

1. Display the Library module
 

2. In the Categories List, click the box next to the category of video you want to search for. A
binocular symbol appears in the box and all values within that category will also be selected

 

 

3. The Item s List will display all clips which are labeled with keywords from that category.

 

Filtering the Item s L ist by keyword

 
1. In the Categories list, click the [+] symbol next to the category containing the keyword you

want to filter by. An expanded list of keyword is displayed.
 

2. Click the box next to the keyword of video you want to search for. A binocular symbol
appears in the box. The Item s List will display all clips which are labeled with keywords from
that category.
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You can select multiple keywords to refine your search
 
 

Removing filters
 

1. EITHER: Click the box next to each category or keyword that you want to exclude from the
filter such that the binocular symbol disappears.

 

2. OR: Click the Show All button  above the Item s List.

3.4.2 Using Search

When using the Categories view, a search box can be found above the Item s List. This can be
used to search for all or part of the text in the file name, keywords and categories of a video clip.
For example a search for "Golf" could yield the following results:
 

 

To use the Search:
 

1. Type search text.
 

2. Click the Search button  or press the ENTER key.
 

 

Combining Search and keyword filters
 

When keywords are used to filter the Item s List, search results are based around the selections
made as follows:
 

Search first - subsequent category/keyword selections filter the search results only.
 

Filter first - subsequent searches are based on filtered results only.

3.4.3 Using Folders

The Folder view creates a way of searching drives and folders on your computer for items.
Although we recommend the use of keywords as a more versatile method for cataloguing your
video library there may be occasions where you prefer to identify video clips by the folder where
they are located. For example if you want to examine the contents of a CD or networked drive
(including these types of location in your video library is not recommended).

 

Filtering the Item s L ist by folder content
 

1. Display the Folders view by clicking the button at the top of the library.
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2. In the Folders view, click the folder you want to examine.
 

3. The Item s List will display all clips in the selected folder.
 

3.5 Saving the tray's content

The contents of the T ray can be saved as a Playlist which can be reopened in the future.  This is
useful for any situation where you will want to work with a collection of clips; creating a Playlist
will be more efficient than locating the same clips in the items list for example:
 

A set of clips illustrating techniques to be practiced in a coaching session.
 

Clips captured during training which you want to keep together for later feedback or editing.
 

All video sources used while Tagging a game (Team Pro).

3.5.1 Creating a playlist

A Playlist is created by saving the tray, to do this:
 

1. Click the T ray button found to the left hand side of the Tray itself.
 

 

2. Select the Save Playlist... option.
 

3. Enter a file name and select a folder location for the Playlist.

Playlists can be saved into any folder you like but if you select one of the library folders (see
Defining your library) your Playlist will appear in the items list with the following icon:
 

 

This allows you to categorize, search for and open clips in the same way as you would with video
clips.
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3.5.2 Reusing a playlist

A Playlist is used by opening it, to do this either double-click its icon in the Item s List or proceed
as follows:
 

1. Click the T ray button found to the left hand side of the Tray itself.
 

2. Select the Open Playlist... option.
 

3. Locate the file on your computer and click the Open button.

 

When a Playlist is created it does not duplicate the video clips it contains but simply instructs
Dartfish where the original clips can be found.  If a clip contained in a Playlist is moved to another
folder, deleted, or the folder containing it is unavailable (for example, a disconnected network
folder or external hard-drive) then Dartfish will be unable to find it.  When the Playlist is opened
you will be offered the opportunity to find the clip.
 

 

If the No button is clicked the Playlist will continue to open the remaining clips (and continue to
warn you if the files are not found).  Remember to save the Playlist if you wish the changes to be
permanent (see Modifying a playlist).

3.5.3 Modifying a playlist

Once the Tray's content has been saved as a Playlist, changes made by adding or removing clips
from it are not automatically saved.  These modifications must be saved using the same
procedure as creating the original Playlist (see Creating a playlist)  You have the choice of saving
a new Playlist with a new name or overwriting the original.

3.6 Sharing video files

The Tray is used to share video to a variety of destinations including network drives, email, CD
and internet.  To learn more about all the outputs from Dartfish see the Dartfish outputs -
publishing & sharing chapter

3.7 Converting video clips

The video which comes from your camera is in a DV (.avi) format. It is possible to use Dartfish to
convert DV video files into other, more compressed formats to reduce the space they occupy on
your hard drive.

Conversion is guided by the Video Conversion W izard.

1. Step1 - select the files to convert from the Item s List or the T ray. To select multiple files,
hold down the [Ctrl] key while clicking on the file names.

 

2. Step2 - Display the T ray or I tem s List context menu by right-clicking on any of the selected
items. Select Convert to launch the Video Conversion W izard.
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3. Step3 - Video Settings. Select an encoding profile. The profile chosen affects the video format
and the degree of compression. For more on video encoding profiles see Converting Video  in
the Getting Fam iliar chapter.

 

4. Step4 - Destination. Choose a destination folder for the video. The default is to return
converted video back to the same folder as the original files. Converted clips will not replace
the originals and will have a different file name. For example, "Marathon.avi" will become
"Marathon.wmv". However, you are able to choose what action to take if there are other
files with the same name located in the destination folder. You can either overwrite the
existing files or rename the converted files.

Clicking the Next button at this stage starts the conversion. When complete, the new files can be
found in the Item s List or T ray.

3.8 Video Formats and Dartfish

Dartfish can play a variety of common video formats.  This allows the use of video content from
a variety of sources and devices.  The following formats are supported.

AVI (DV - PAL, NTSC - Type I & II, uncompressed and DivX)

High Definition (HD) in HDV or AVCHD

Windows Media (WMV)

MPEG (MPEG-1, MPEG-2)

MPEG4 (H.264-AVC)

The file types listed above are a broad guide - some devices and software encode video files
using codecs that cannot be decoded by Dartfish.  Others may create files with a proprietary file
extension that is not recognized by Dartfish.  Our advice is to try to play it and you'll soon find
out if it works!  Check out Dartfish Support for further advice.

HD (high definition) video and Dartfish

The increased resolution of HD video can be highly beneficial for video analysis however it also
has downsides.  Four times more pixels can require more storage space and processing power,
although this varies considerably depending on the encoding bit rate used by your camcorder. 
The difficulty is not just with image resolution; the complexity of encoding profiles such as MPEG-
4 require five times more processing than standard definition MPEG-2. The result may be that
analysis tasks such as split-screen comparison or even frame-by-frame playback require above
average computer resources.  

For those using HD it is particularly important to be aware of the recommended computer
specification.
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3.9 Correcting video property errors

Some video devices produce video which fails to describe, or describe incorrectly, certain video
features and this can lead to problems with appearance.  Dartfish allows you to manually correct
video properties.

To display the video properties:

1 . Right-click the video item in the Library's I tem s List or T ray

2 . Select Properties from the quick-menu

3. Select the Source Info tab

The following errors can be corrected:

Interlacing errors

Interlacing errors occur when the two fields which comprise each frame of interlaced video are
incorrectly displayed.  If interlaced video is incorrectly described as progressive then a
characteristic jagged edge is seen on moving objects, such as shown below.

 

Where the two fields are displayed in the wrong order, the video will appear to jump back and
forwards when played frame by frame or in slow motion.

Aspect ratio errors

When a video is displayed in the wrong aspect ratio the image will appear distorted; squashed or
stretched.

Rotation errors

Rotation errors can happen when the camera has been held in portrait orientation so the video
looks like it is on its side when played.

To adjust properties

Only properties with a pencil icon next to them can be edited.

1. Click on the value to edit

2. Select the correct value from the drop down list

3. The corrected value is displayed next to the original value as shown below:
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3.10 The next steps

This chapter covered the use of the Library and explained how to create a library using 
Categories and Keywords to manage video clips. Specifically, you learned to:
 

Define folders and drives to be contained in the library.
 

Define appropriate Keywords for your needs.
 

Describe the content of your video clips by using categorized keywords.
 

Share video by disk, email or Internet.
 

Archive and backup video on CD.

We recommend that you take some time now to define the folders and/or drives that you want
in your library, create categories and values suitable for your use of video and then, if you have
existing video clips, assign appropriate values to each.
 

If continuing your journey through Dartfish Help then you might want to learn how to import
video and capture video 'live' using the InTheAction Module (read chapter Live capture & instant
replay during training).
 

Dartfish is also able to share video by producing Media Books from the Analyzer module.





Chapter

IV

Importing files to the
library
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4 Importing files to the library
Dartfish imports files to its library by one of two processes; Video Recorder or Video f ile
Im porter.  Access to these tools is via the Im porter button on the toolbar which allows you to
select an import method from its drop-down menu.

If you are not sure which tool is best for you, click the Im porter button itself and choose from a
list of video devices and sources. Dartfish will then start the correct tool according to your
choice.

Video File Importer

Copies files from any disks or folders internal to, or connected to, your computer.  This includes:

Camcorders recording to hard-drive or internal memory

DVD camcorders

DVDs or CDs in your computer's optical drive

Card readers

Folders on your computer, network or external drive.

Video recorder

Records a live feed from a device capable of delivering a video stream; this is recorded by
Dartfish to create new video files.  The most common instance of this being the replay of
recordings on the tape or the live stream from a DV or HDV camcorder (uses DV tape
cassettes). This method also applies to any device providing a live video stream, for example:

DV and HDV camcorders as described above

Video converter devices (analog to digital, HDMI to DV etc).  These devices are used to
convert the video output from devices which don't provide a digital stream

Webcams

IP Cameras

Other ways of adding files to your library

There are two further modules which record a live video stream, but they are only found in
certain editions of Dartfish:

1. InTheAction facilitates the entire process from video capture to analysis for those who want
to give immediate feedback.

2. Live tagging has a specialized version of the video recorder which allows an index of video
content to be created while recording.

For the sake of completeness there are three further ways in which files can be added to the
Dartfish library:

3. A new folder is added to the list of folders monitored  by Dartfish (see Defining your library).

4. The results of a Dartfish project are saved.

5. Video files are copied or saved into a library folder by a process external to Dartfish, for
example by using MS Windows file management tools or by using the import software
supplied with many camcorders.

When new files are added to a monitored folder by an external process they won't
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automatically appear in the Library -  you must remember to refresh.  From the menu bar
choose View > Refresh.

4.1 Using the Video File Importer

The Video F ile Im porter copies files from any device on which Windows is able to recognize a file
structure (for a fuller description see Importing files to the library). 

To import video files into the library:

1. Connect the external device or insert media into the appropriate drive. If the device doesn't
simply plug and play you may need to refer to the device's documentation to learn how to do
this.  For example, many camcorders require that you select a connection mode.

 

2. Select Video F ile Im porter from the drop down menu on the Im porter button.

 

3. A step-by-step Wizard is launched to guide you through the process of selecting, copying and
categorizing video files.  The steps of the wizard are covered in the following topics.

Importing files from Camcorders

Many camcorders permit a maximum file size so when you make long recordings several video
clips are created.  For certain types of device (currently AVCHD camcorders and DVD) Dartfish
automatically detects sequential files and creates a single video clip.

Indexing video

Some video formats do not have an index; preventing accurate identification  of video time
position. Tasks which rely on this, such as stepping through the video and synchronizing multiple
clips, become unreliable.  Dartfish creates an index when these videos are imported or opened.
Access to the video is delayed during indexing, but the index is retained allowing immediate
subsequent access.

Importing from DVD

In addition to importing files from data CDs/DVDs and importing from DVD camcorders via a USB
connection, Video File Import copies video files from a video DVD in a form that can be used in
Dartfish software : the DVD's VOB files will be renamed with an MPG file extension to allow them
to be played by Dartfish.

DVD import is not designed to capture a video stream from a DVD player. In order to import
DVDs your computer must have a disc drive capable of reading DVDs or import is direct from
the DVD camcorder connected by USB.

If your computer's DVD player automatically plays the disc after insertion, stop it and close
the player to allow Dartfish to access the  disc. 

Many commercial DVDs are copy protected.  Dartfish will be unable to import video files from
copy protected DVDs.  Video DVDs that have been created by a home DVD Video Recorder or
a DVD camcorder are usually not copy protected.
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4.1.1 Video File Importer - selecting files

In the first step of the importer you choose the source of your files and then can select or
deselect which files you wish to import.  

Select source drive

Select a device or select the Browse... option to select a specific folder. 

Even if you made a specific choice of video source from the importer, all connected sources are
listed. When selecting the source remember it may not always be obvious how your computer
identifies your device; in the example below the camcorder is simply identified as "Removable
Disk (G:)"

Dartfish automatically recognizes the file structure on certain devices and displays the videos
from that device.  On other devices it will be necessary to browse and select the appropriate
folder.

Select Files

Files are selected by placing a tick in the check box at the top right of the thumbnail.

Proceed to the next step by clicking the Next button at the bottom of the Importer

4.1.2 Video File Importer - naming and filing videos

In the final 2 steps of the wizard you will define file name, assign keywords and select a folder for
the imported files.

File name

The title has two roles depending on the source device type:

For sources which Dartfish will join concurrent files (AVCHD camcorders and DVD), the title
represents the name of the new file that will be created.

For other sources, the file name allows you to rename the often meaningless name assigned
by the camcorder.  The same filename will be used for all imported files but suffixed with an
index number e.g. filename(1)

Add keywords to video clips

Dartfish keywords can be added to video clips as they are imported.  As discussed in the 
Organizing your library topic, keywords are a highly effective way of cataloging video content. To
add keywords you will create a matrix of categories and keywords.
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Edit the matrix by clicking to select and then clicking again to edit. Press the Enter key to
confirm your selection.

You can type a new category or keyword or select one already existing in the Library

The matrix you create will be retained for future imports. You can choose not to use a
keyword simply by editing and deleting it: If a category in the matrix has no keyword, no
keyword will be applied.

Select destination folder

The final step before import allows you to choose the destination for imported files.  This is the
Windows folder where your files will be stored.

Even if you use keywords to organize your library, your files are still stored using the Windows
folder system.  It is perhaps best to import to one of your library's monitored folders but any
folder you choose will automatically be monitored by Dartfish.

It is recommended that you choose a folder on a local drive, rather than on a network; this will
ensure rapid copying and smooth playback and analysis

The folder structure of the removable media will be maintained after import.  For example if my
memory stick contains a file K:\Videos\file.mpg it will be imported as ..\destination folder
\Videos\file.mpg.

 Finish

Your final choice is whether you wish the imported media to be included in the T ray. Regardless
of the choice made, of course all media can be located in the Library Item s list.

4.2 Video Recorder: capture a video stream

Video recorder versus video file importer

These days we have grown used to using camcorders which record video files which can then be 
transferred to a computer. However, an alternative workflow is to have the video device feed
video directly to the computer. The computer then creates the video file.

In the case of DV/HDV camcorders using tape, webcams and IP cameras, streaming is the only
way to get video onto a computer. For the Dartfish user the advantage of recording versus
importing is that the video is available for analysis almost immediately.

The Video Recorder is the Dartfish module which is used to record video from tape camcorders
and other devices providing a video stream.
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Tape camcorders

A DV/HDV camera is connected to a computer via a firewire cable (also known as IEEE 1394 or
i-link). This requires that your computer has a built-in Firewire port or an Express card slot which
would allow one to be added. There are different types of Firewire so be sure to buy the correct
cable. In general, your camcorder will have a 4 pin connector. Your computer can either have a
4, 6 or a 9 pin connector.

"4" pin connector 
to Firewire port

"6" pin connector
to Express card

To capture recorded video from tape, switch on your camera to its "Play" or "VCR" mode. To
record a live stream, switch it to "Record" mode

Tapeless camcorders plus video converters

Modern camcorders no longer stream video in a form that can be directly recorded by a
computer. To obtain a live stream it is necessary to use converter hardware to convert the AV
output. This can be analog (usually composite or s-video) or digital (usually HDMI). Digital is the
preferred option and to retain full HD video the HDMI output must be used.

In theory, Dartfish can work with the video produced by a wide range of converters. In practice,
it is hard to predict which will allow Dartfish to manage the recording process. For this reason we
recommend several converters which we know will work:

Device Connection Notes

Blackmagic H.264 Pro Recorder HDMI/SDI > USB Professional quality digital
converter. Requires power
supply.

Canopus ADVC 55 / 110 Composite > Firewire Professional quality converter
but this model offers analog,
standard definition video only.
Firewire connection needed. Can
be powered via Firewire if 6-pin
cable used.

Canopus ADVC HD50 HDMI > Firewire Professional quality converter
providing HD video. Now
superseded by the Blackmagic
as laptops with Firewire not
readily available.

Terratec G1 Composite > USB A budget solution which uses a
USB connection and does not
require any additional power
source.
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Webcams

Webcams are suitable for some types of analysis; generally where there is limited camera
movement and where the better image control and larger optical zoom of a camcorder is not
required. Dartfish recommends webcams which offer an MJPEG stream, otherwise the stream
will be relatively uncompressed and require greater processing power, perhaps beyond the
capabilities of lower specification computers. Particularly recommended is the Microsoft Lifecam
Studio for the following reasons:

Good image quality - the Lifecam has a glass lens and good quality sensor and has some
automatic image improvement features, plus it is possible to have some control over zoom
and exposure

Fixes to standard tripod

MJPEG video stream

IP cameras

An IP camera is a device which streams video across a network using internet protocols (IP).
There are a wide range of IP cameras offering a wide range of features and although designed for
security or other monitoring purposes, they can offer a practical solution for live video capture
needs with Dartfish.

IP cameras are ideal for fixed installations: Stadiums, gyms, sports halls, golf driving ranges etc.
The camera and cable infrastructure is fixed and all the user has to do is come with his laptop and
connect to the network. Because that network might even be a wireless network, one can
imagine possibilities that this offers to Dartfish users. Furthermore, multiple cameras can be
connected to the network and the user can pick which he wants to view/record.

Simpler use cases such as bike fitting or gait analysis are also candidates, but only where the
benefits listed above plus better lenses and better zoom capabilities, outweigh the low cost and
easy connection advantages of other solutions such as the MS Lifecam webcam. 

Cameras complying with the Onvif standard are supported. Where PTZ is required the device
must comply with Onvif version 2.

4.2.1 Setting up the capture device

To activate the video recorder

 Select Video Recorder from the drop down menu on the Im porter button.

Selecting a Capture Device
 

The lower part of the DV import module contains several settings. Clicking the headings expands
each setting to view the details. 
 

In the Capture Device section the video (and optionally audio) devices are selected:  Select your
camera from the Select capture device drop-down list. When a successful connection to a
camcorder is established the Record button will be active (red) and the streamed video is
displayed in the  video display .
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If the device or camera that you are using does not appear in the capture device list, it is possibly
because of one of the following reasons:
 

Camera not switched on. (Remember cameras auto switch off after a short time if unused)

Correct cable not present or disconnected (a firewire can easily work loose).

Camera not properly installed and recognised by Windows. 

Hardware fault with firewire cable or camera or capture card.

For more information about the types of device which can be used by the video recorder see the
following topics

Video Recorder: capture a video stream

Setting up the Lifecam webcam

Configuring an IP camera

4.2.2 Setting up the Lifecam webcam

The Microsoft Lifecam studio is the webcam recommended by Dartfish because of its video
quality and ability to provide a MJPG encoded video stream. To set up the webcam, connect it via
its USB cable, then:

Select Video Recorder from the drop down menu on the Im porter button.

The Capture Device settings are found in the settings section below the video display: Select
Microsoft Lifecam Studio from the Select capture device drop-down list.

When a successful connection to a camcorder is established the Record button will be active
(red) and the streamed video is displayed in the  video display .
 

Configure format
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Click the  button to the right of the selected device to configure these recommended video
settings: 

Frame Rate: 30.000 

Color Space / Compression: MJPG 
If this option is unavailable see trouble shooting steps below

Output Size: 1280 x 720
You may prefer to use a lower resolution if working with a computer below Dartfish's
recommended specification

Configure device

The Lifecam offers features which allow you to improve the image:

1. Click the  button to the right of the selected device

2. Click the Cam era Control tab

3. Experiment with settings to achieve the best image. Pay particular attention to the Exposure
setting to reduce motion blur.
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Toubleshooting

The Microsoft driver software prevents Dartfish from getting access to the MJPG stream. To
resolve this it is necessary to select a generic USB webcam driver. The way to do this depends
on your operating system.

W indows 7/Vista

1. Uninstall Microsoft Lifecam software using Windows Control Panel

2. Always click Cancel when the invitation to install Lifecam software appears

W indows 8

The Lifecam driver is built into Windows and should not be uninstalled. Choose the alternative
driver as follows...

1. Open the Windows Device Manager program

2. Look for Im aging devices > M icrosoft LifeCam  studio, right click this and select Properties

3. Click the Driver tab

4. Click the Update Driver... button
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5. Select Browse m y com puter for driver software

6. Select Let m e pick from  a list of  device drivers on m y com puter
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7. Select USB Video Device, then click the Next button to complete the installation

4.2.3 Using Network (IP) cameras

An IP camera is a camera that streams video across a network. In this topic we start from the
point of assuming that your camera is successfully set up on your network and is accessible to
the computer(s) that will record from it.

Who uses IP cameras?

IP cameras are ideal for fixed installations: Stadiums, sports halls, tennis courts, golf driving
ranges, classroom monitoring etc. The camera and cable infrastructure is fixed and all the user
has to do is connect his computer to the network. Because that network might even be a
wireless network, one can imagine possibilities that this offers to Dartfish users. Furthermore,
multiple cameras can be connected to the network and the user can pick which he wants to
view/record.

Simpler use cases such as bike fitting or gait analysis are also candidates, but only where the
benefits listed above plus better lenses and better zoom capabilities, outweigh the low cost and
easy connection advantages of other solutions such as the Microsoft Lifecam webcam. 
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Dartfish support for IP cameras

Cameras compliant with the ONVIF standard are supported. Where PTZ is required the device
must comply with ONVIF version 2. 

In theory, Dartfish should be able to record from any ONVIF compliant device. In practice, the
implementation of the standard is variable between manufacturers and we are continuing to learn
how to make all function optimally with Dartfish. As we learn more about how ONVIF is
implemented, we can expect a wide range of cameras to function without any need for further
software updates. 

There are three parts to configuring an IP camera:

1. Use the camera's own configuration tools to define some essential parameters as well as
other features of the video

2. Enable Onvif plugin

3. Select camera and (optionally configure video/audio stream)

4.2.3.1 Configure an IP camera

The initial configuration of the camera is typically done via its web page simply by entering the IP
address of the camera into a browser but a dedicated utility may be provided by the camera
manufacturer. Consult the camera user manual on how to access and configure the device.

Important parameters

Some properties of the video stream can be modified directly from Dartfish later. Among those
which can only be defined from the camera configuration, it is important to check the following:

Update f irm ware: There may be a button or link to do this on the configuration page.
Otherwise, the manufacturer’s support website should be checked to discover if there is an
update. Interoperability with Dartfish may depend on this.

Set date and tim e of cam era: This may be important to ensure correct communication
between the camera and computer.

Set sensor base fram e rate: The sensor frame rate must be set to the frequency of the AC
power of your country e.g. 60 Hz/fps for the US and 50 Hz/fps for Europe. Failure to do this
may result in poor image quality and flickering video.

The sensor frame rate is not the same as the frame rate of the video received by Dartfish. You
can configure that from Dartfish.
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4.2.3.2 IP camera setup in Dartfish

Enable network camera

1. From the Dartfish Tools m enu > Options > Network cam eras

2 . From the list of plug-ins, select ONVIF IP Cam era then check the Enable plug-in option

3. Enter user name and password (if user profiles defined for camera require login)

The login relates to user profiles created on the camera. Dartfish does not allow the user to
login to individual cameras but instead offers a global login which gives the user access to all the
cameras with user profiles with those login credentials.

HTTPS or HTTP?

Selecting the Use HTTPS when available option ensures that communication between camera
and computer is secure. However, be aware that:

Not all devices offer HTTPS encryption. Ticking the box here has no effect.

HTTPS does not encrypt video, it only provides secure communication between camera and
computer of information such as login.

Device selection

Select Video Recorder from the drop down menu on the Im porter button.

Any available camera can be selected in the Capture device section of the module. 

After selecting a camera, buttons to configure video, audio and (if available) PTZ settings will be
displayed next to the selected device.
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When a successful connection to a camera is established the record button will be active (red)
and the streamed video is displayed in the  video display .

Disabling the audio source

Unlike other sources of video, when using an IP camera, it is not possible to use a different audio
source other than the camera. It is possible to disable audio recording:

1. Click the Conf igure audio button

2. Select the profile that you want to use according to your video requirement

3. Click the edit button

4. Choose  (None) for the AUDIO SOURCE property

Audio is switched off on this media profile for all users of the camera and not just for the
software where the choice was made, be aware that the change may affect other users.

Configure video properties

It is possible to set some common properties of the video stream using Dartfish software: Click
the configure format icon shown next to the selected device. The optimal/easiest way to define
video settings is to choose one of the camera’s pre-defined profiles. However, to meet the
bandwidth requirements of your network or particular analysis needs, you may want to create or
customize a profile.



56 Dartfish User Guide

© Dartfish. All rights reserved. - Version 7 -

Encoder:  H.264 and MJPEG are supported. MPEG-4 is not supported
H.264 offers better image quality/compression ratio but may introduce latency (delay in the
‘live’ image appearing on the screen).
MJPEG generally provides lower latency but for any given quality file sizes will be larger

Frame rate/encoding interval: For technical analysis we often want the highest possible frame
rate so you should be aware that media profiles can use both these properties to define the
effective frame rate i.e. the frame rate at which the device is encoding and delivering frames
to Dartfish. To configure the effective frame rate, some devices use the frame rate
parameter, others the encoding interval and others use both in combination. In the latter case
the encoding interval parameter influences the frame rate parameter 
e.g. base frame rate = 60, frame rate parameter = 30, encoding interval = 2, effective frame
rate = 15 fps. 

Resolution: Choose a resolution which allows the level of detail required for analysis.

Quality: Set between 80-100%. Quality below 80% is usually not suitable for video analysis. 

Bitrate: This property sets a bit rate limit so it is best to configure it to something that is
supported by the network e.g. 5 Mbps for SD video and 8-12 for HD video, then adapt the
other settings to provide the best image quality within the specified bitrate constraint. Frames
are dropped if the bitrate property is exceeded.

This is a generic set of properties defined by the ONVIF standard. Some cameras may not allow
certain properties to be modified by the user e.g. in the image above, encoding interval cannot be
set.

Also remember:

 Other video settings (where available) can be modified on the camera’s configuration page
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 Some or all settings may be unavailable to you if your user profile does not have
administration rights

 Creating and modifying media profiles affects all other users of the camera

Configure audio properties

Audio encoder: G.711 and G.726 codecs are currently not supported. The audio encoder
must be AAC.

Check if the media profile configuration is appropriate

Just because a video image is seen in Dartfish does not mean that it is a correct video image!
The frames per second (fps) indication shown in the Dartfish status bar provides a good
indication when there are problems with the configuration. 

e.g. in the above image the bit rate exceeds the capacity of the network - you can see that the
video stream being sent by the camera is 60 fps but video is being displayed at 32.6 fps.

4.2.3.3 Pan-tilt-zoom control

Configure PTZ (Pan-tilt-zoom)

Some IP cameras allow remote control of the direction and zoom of the camera. Dartfish
supports PTZ by providing a PTZ control

To display the PTZ control, click the PTZ button next to the selected device (or right click the
video display)

 

On the left of the PTZ control, buttons remote control pan, tilt and zoom and on the right there is
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a list of preset positions. 

Create a preset by:

1. Pointing and zooming the camera

2. Click the Save button

3. Enter a name for the preset

Users of Dartfish tagging can add a PTZ move button to a tagging panel to integrate
camera control into the tagging workflow. 

4.2.4 Setting Clip Properties

Use the Clip Properties to set the F ile Nam e, Categories and Keywords for newly captured clips.
This information defines a so-called Capture Form that will be used to categorize the video clips
during capture. 
 

Read the section Organizing your library to learn more about categories and keywords.

Defining the Capture Form
 

1. Click the Add a category link . The Add Category dialog will appear.

2. Select a category from the list or create a new one.
 

3. Click OK. A new category box will appear on your Capture Form.
 

4. Repeat steps 1-3 until boxes for all the categories you want to use are displayed on your
form.

 

Using the Capture Form
 

1. Type a file name in the file name text box.
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Each file captured using this file name will be numbered sequentially. For example if you type
"Training Apr10", each captured clip will be named T raining Apr10(1), T raining Apr10(2) etc.
 

The filename you use must follow MS Windows file naming rules: Max length 256
characters; use of ":", ";", "/" or "\" is not possible.
 

If no file name is specified a generic name of Untitled(1) etc will be given.

 

2. Select the keywords you wish to give the clip by selecting them from the drop down list for
each category box. For example, you might intend to capture all of the men's Giant Slalom
competitors in Chamonix. Your form should look like this:

If a keyword does not already exist, for example a new competitor, you can type that value
into the appropriate box. This new keyword will only appear in the Library module's
categories list after clips have been captured.
 

 If a category is to remain with no keyword, for example if the name of a competitor is
unknown, the value may be deleted from that category box (select it and use the Backspace
key on your keyboard). Do not use the Clear button  as it will remove the category box
from the form.

4.2.5 Using Recording options

A difficulty when recording a video stream is to guess when the action that is to be recorded will
start. It is common to start recording too early and create a file that is longer than necessary.
Worse still, recording is started too late.  Recording options are intended to prevent this.  There
are two recording options:
 

Pre-record - constantly stores a defined number of seconds of video in the computer's memory.
When recording is started the stored video is included in the video file created.  Setting one or
two seconds of Pre-record compensates for user and computer reaction time.
 

Recording Duration - it is possible to define how long the captured clip will be.  Recording will
automatically finish at the end of the defined duration.  This simplifies recording to the single
button press that initiates it but it is especially valuable when longer videos are to be recorded;
for example, start recording a game and return one hour later when it has finished.

 To set Recording options
 

1. Expand the Recording options section
2. Select the setting (tick box)
3. Set the value by editing the time directly or by using the Up-Down buttons.  Note that time is

displayed in Hour:Minute:Second format.
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In the example shown here a 2 second pre-record is being used but the 5 second recording
duration is not and recording will be stopped manually.

Recording after the action has completed
 

The tape may show many actions which are of no value to you.  How can you efficiently select
which of these you want to record for use in Dartfish?  By setting a larger Pre-record it is possible
to make an assessment of which actions are worthwhile.  In the example below, recording is
only started AFTER the jump has completed:  A pre-record of 4 seconds allows for decision
making time and by also setting the recording duration to 4 seconds we ensure that it is always
the previous 4 seconds that are recorded.
 

4.2.6 Selecting a recording location

The Recording folder setting both displays the current Windows folder where video will be stored
and allows you to select a different location.The recording location default is the "Videos" folder
on your computer.   To change recording location:

1. Click the Change recording location link. The following dialog box appears:
 

 

2. Select a folder from the list or click the M ake New Folder button to create a new folder in the
currently selected folder.
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Choosing a recording folder

Apart from organizing your files where it is convenient to find them in the future you must
choose a drive with sufficiently fast write-speed.  

Video files are large and data-rich so attempting to save to a location where the file writing speed
is too slow is akin to quickly pouring a lot of water down a narrow pipe!  The result is dropped
frames and jerky playback.  Typically, data transfer to a network location is too slow to
successfully create video files.

 Record to a local drive and then use the Share function of the Library's T ray to copy
the files to other locations. 

4.2.7 Using an encoding profile

Dartfish can encode video as it is recorded.This is used to:

Reduce video file size.

Prepare the video for its final destination. For example, video which will be played from an

optical disc or streamed across a network or the internet must have a  appropriate bit rate in
order to achieve smooth play back
Reduce dartfish.tv publishing time. If the encoding profile of your channel is used while
recording, re-encoding is not necessary during publishing

Record video stream

Select this option to create a video file using the video encoding provided by the video source.
The original format is displayed next to this option and from some sources it is possible to select
from multiple formats.

Create converted clip

Select this option to create a video file using the selected encoding profile. See Converting video
for further information on the different encoding profiles.

Add to tray options

When both Record video stream and Create converted clip are selected two video files will be
created. These options allow you to decide which file(s) will be loaded into the Tray after
recording and therefore be immediately available for use.

Creating two files is useful when a high quality backup is required or when two formats of video
are required for different purposes.

Edit profiles

This link takes you to the encoding profile options where you can:

 Learn about the bit rate and file sizes of the encoding profiles provided by Dartfish

 Download the encoding profile for dartfish.tv channels
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When a converted clip is created from a video source which already provides encoded video,
background conversion is used. The video stream is always recorded until the conversion is
completed successfully. This has the following implications:

When recording is stopped there may be a delay before the clip appears in the library.
Conversion progress can be monitored using the background task manager

If conversion fails, the original recording should be available as a backup - whether or not the
Record video stream  option is selected

Unencoded video streams e.g. RGB or YUV are converted directly without using background
conversion

 Although encoding during recording offers the convenience of a video file already suitably
encoded/compressed for its final purpose, it is possible to re-encode any video file in the library
simply by right-clicking it and selecting Convert from the context menu.

4.2.8 The background task manager

When the Convert in background option is used to encode (convert) video as it is captured, the
full quality video is stored by the computer until sufficient resources are available to complete the
conversion.  This may not happen until some time after the capture.
 

The Background task m anager helps you keep track of the progress of creation of encoded clips
and if neccessary allows cancellation of the process.

 

To view the background task manager
 

1. From the T ray section of the Library, click on the Tray button.
 

 

2. Select Background Task M anager from the menu.
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To cancel tasks

If the progress indicator for a task shows that it is not yet complete  then the task

can be cancelled by clicking its close button .  Clicking the same button on completed tasks
does not undo the process, it simply removes the item from the list.  All complete tasks can be
removed by clicking the C lear button.  This may help in identifying which tasks are still
incomplete.

4.2.9 Capturing video to Library

Once setup, the process of capturing video is a simple one; you have to locate the position on
the tape where the footage of interest is recorded and then click a single button to start and then
stop capture at the beginning and end.
 

Finding footage on tape

 The DV Import module has a set of controls that you can use to control the camera. 
 

 

Alternatively, you can use the equivalent controls on the camera itself.
 

Capture video

Click the record button  at the start and end of the clip.
 

The pause recording button  allows you to pause capture while the tape continues to run. This
allows you to create a single clip when the action is split. For example, coach intervention in the
middle of a trampoline routine or a fall while skiing can be ignored.
 

Replaying captured clips

The clips you have captured will now be listed in both the T ray and Item s List of the Library
module. Load the video by double clicking on it. The video clip will open in the Player module.
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4.3 The next steps

This lesson covered ways to import video files or record a video stream
 

If continuing your journey through Dartfish Help then you might want to learn how to capture
video 'live' using the InTheAction Module (read chapter Live capture & instant replay during
training).
 

Dartfish is also able to share video by producing Media Books from the Analyzer module.



Chapter

V

Live capture & instant
replay during training
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5 Live capture & instant replay during training
The InTheAction module is a combination of Dartfish capture, replay, comparison and analysis
features brought together in a way that allows the delivery of video feedback during training
sessions.  

The aim here has been to make the technology easy to use without the presence of a computer
being disruptive to training itself.  Some of the key features which allow this to happen are:

 

Remote controlled - for complete ease of use, a single button on the remote control can control
both capture and replay.

 

Simplified video capture - in automatic mode only trigger capture at the start of the action.  A
fixed number of seconds is captured from this point.

 

Automatic instant replay - replay happens automatically as soon as capture is complete.  Pause
and set replay speed by remote control.

 

Comparison - compare captured clips side by side with a reference clip.
 

Synchronization - synchronization of clips is based around the moment when you trigger
capture making comparison of 2 clips both easy and quick.

 

Drawing/annotation tools - illustrate coaching points using a range of drawing tools

5.1 Preparing InTheAction for use

At the start of your coaching session using InTheAction you will spend a short time preparing
InTheAction for use.  Of course you'll need to connect the camera, perhaps more than one camera,
also in this section you will learn to adapt the recording and play parameters according to your
specific needs.

5.1.1 Selecting capture device

IMPORTANT NOTE:  About using video devices with InTheAction

InTheAction works by establishing a link that allows live images to pass directly from camcorder
to computer.  For this reason it only works with camcorders and devices capable of providing a
video stream.  DV and HDV tape camcorders can do this streaming but the latest HDD and SD
card camcorders do not offer this functionality.  

It is still possible to use InTheAction with these camcorders in conjunction with converter
hardware: the camcorder's video output to TV is connected to the converter which creates a
digital video stream which can be used by Dartfish. Converters can be used with analog and HDMI
video sources.

Further advice on sources of video can be found in the topic  Video Recorder: capture a video
stream

The latest advice on the use of camcorders and other imaging devices can be found on the 
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support section of our website.

The information below applies equally to DV camcorders and other video streaming devices.

Setup capture devices

After connecting the camera, the next step is to launch the InTheAction module and select your
camera as its video input.  To launch the InTheAction module click on the InTheAction button on
the toolbar:
 

 

InTheAction module has two tabs at the top of the module: 
 

 

Setup Input Devices - to select the capture device(s); choose the appropriate device from

the drop-down list. Once selected, you should see the images transferred from capture
device (camera).
 

 

If your device is not listed, make sure that your equipment is correctly connected (see
Video Recorder in the Video Library chapter), switched on and has not automatically switched
off - many cameras do this after a fixed interval. Taking the tape out of the camera prevents
automatic power off every few minutes.
 

Usually input device selection is only required the first time you connect your camera to
your computer.  It is necessary if there is more than one input device or if several different
cameras are used.

 

InTheAction - is where the capture and replay features are found. Click on this tab once you

have selected the capture device.

5.1.2 Using more than one camera

If your computer has two firewire inputs, a second camera can be connected, allowing InTheAction
to capture two video clips simultaneously.  For example, rear and side shots.  InTheAction allows
simultaneous replay of both clips.

 

Choosing multiple video inputs
 

Unless you choose to use multiple video inputs when you installed Dartfish you will first need to
activate the option to use two cameras.  To do this:
  

1. Open the Dartfish options, select Tools>Options from the Menu bar (F3).
 

 

2. Select the  InTheAction topic
 

3. Click the 2  (need identical device type) option
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Indentical devices are recommended because it requires much more computing power to

process the video from different hardware.

 

Setting up multiple video inputs
 

1. Launch the InTheAction module.
 

2. Select the Setup Input Devices tab.
 

3. Select the second camera from the corresponding drop-down list

5.1.3 Defining recording folder

The lower part of the InTheAction module allows you to set the Recording Folder, i.e. the folder
where the captured clips will be saved on your hard disk (see Organizing your library in the Video
Library chapter for more info).  To do this, use the Change recording folder as illustrated below:

 

5.1.4 Defining clip properties

If you intend to keep the video clips in your library you should define the clip properties which will
be assigned to the video files that are saved. 

Use the Clip Properties to define:
 

the F ile Nam e - enter the file name in the text box
 

the categorization of captured video clips - use the Add a category link to add a category

and/or keyword (see Organizing your library in the Video Library chapter for more info)
 

 
 

Once defined, these properties will assigned to all subsequently captured clips, until a new file
name or category/values are specified.

5.1.5 Defining pre-record & clip durations

InTheAction module lets you capture video clips in a single click. To do this, you have to specify
the Clip Duration and pre-record Duration values.
 

What is Recording Duration?
 

Based on the type and duration of the action that you want to record, you need to define the
approximate Clip Duration of the video you are going to capture. For instance, the duration of a golf
swing is approximately 3 to 4 seconds from the address to the finish of the swing. 
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What is pre-record Duration?
 

If you wait until you see the golfer start to swing before starting to record, you may miss the first
moments of the swing.  To avoid this you should set a pre-record Duration value which

corresponds to the second(s) of video footage that took place before you started capture.
 

Pre-record forces the computer to continually remember the number of seconds you specify.
When you trigger capture it includes these seconds at the beginning of the new clip. Usually just a
few seconds of pre-record are required but the maximum amount is limited by the amount of
available memory (RAM).

 

When should you start capture?
 

The moment when you trigger capture also creates a Default Synchronization point on the
captured video. Synchpoints are used to easily synchronize video clips for comparison (see 
Synchronizing clips in InTheAction).  For this reason it makes sense to trigger capture at an obvious
point for comparison e.g. when the club strikes the ball as shown in the following diagram.

 

To define the pre-record and clip durations.
 

The current settings for pre-record and clip durations are displayed at the bottom of the InTheAction
module as shown below.
 

 

To change these settings:
 

1. Tick the box next to the pre-record value if a pre-record is to be used.
 

2. Set a value for pre-record duration according to the advice above.  The largest pre-record
duration you can set is related to the amount of available RAM memory of your computer.  It
is possible to increase the amount of memory dedicated to storing pre-record (see About
pre-record buffer).

 

3. Tick the box next to the recording duration value if you want recording to automatically stop
after a fixed duration.  If this is left unticked you must start and stop recording manually.

 

4. Set a value for recording duration.  Remember that the pre-record duration is included in the
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total recording duration i.e. for the settings illustrated above a 10 second clip and NOT a 13
second clip is created.

If the pre-record is set to the same or greater value than the recording duration it is possible
to wait until after the completed action before triggering recording.  This allows you to assess
whether a performance is worth recording before deciding whether to record or not.

5.1.6 Defining a replay sequence

Once you have captured a video clip, the InTheAction module will replay it automatically based on
the criteria defined in the Replay Sequence. 
 

By default, no scenario is used for the replay sequence and replay speed is manually controlled by
the user. Defining a scenario automates this. 

Creating a replay sequence example
 

In the following example, a 5 second pause allows the athlete to join the coach at the computer
screen, together they then view the clip once at full speed and then in slow motion. To create such a
scenario:
 

1. Display the InTheAction options (F3 > InTheAction).
 

2. Activate the replay sequence function by clicking the Use a Replay Sequence check box.
 

3. Click the Configure Replay Sequence button 

 

4. Click the Add Pause button and set the Duration.
 

5. Click the Add Replay button and set the Speed to x0.5.  The Replay Sequence is ready to use
and appears as shown in the following image.

 

 

When using a replay sequence it is still possible to control playback (pause, play etc.) by the
other video playback controls and remote control.

5.1.7 About pre-record buffer

By default, Dartfish uses half the available RAM memory to store pre-record.  If you are unable to
set enough pre-record  it is possible increase the memory buffer reserved for pre-record.  
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To increase Pre-record buffer
 

1. Select the Setup Capture Devices screen of InTheAction .
 

2. Drag the slider to define the size of the buffer.
 

 

The blue section shows the memory being used by other processes, the green section shows

the memory dedictated to pre-record.  The green section turning red is an indicator that
more pre-record buffer than is advisable has been set.  This is liable to affect the performance
of Dartfish and other functions of your computer.

5.2 Instant visual feedback during training

Once you have defined the InTheAction settings (see Preparing InTheAction for use), you can start
using the InTheAction module. These are the steps:
 

1. If using the remote control (see Remote controlling InTheAction), use full-screen view (type F11
).  Recommended to give the largest possible video image.

 

2. Capture a video clip.
 

3. The clip automatically replays.
 

4. Repeat for the next action

5.2.1 Capturing and replaying

Trigger Capture
 

1. The camera should be in it's camera mode and the video image from the camera should be
visible when using InTheAction's Live view. The choice of views is controlled by the buttons at
the top left of the module; Live, Simple Replay, Blank, Comparison and Reference replay. 

 

  Live view - shows the image from the camera  

  Sim ple Replay view - shows replay of the last captured clip or any clip opened from the

T ray.

  Blank view - blanks the screen (prevents it being a distraction!).

  Comparison view - compares the replay clip with the reference clip.

  Reference replay view - shows replay of a reference clip.
 

It is not necessary to be in Live view to capture but it gives guidance that the camera is
pointing in the right direction.

 

2. Click on the red Capture button or use the equivalent remote control button (see Remote

controlling InTheAction).  
 

 

The duration of the clip will depend on the Clip Duration property (see Defining pre-record &

Clip durations).
 

 

Viewing:
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Once you have captured a clip, the replay sequence will start automatically. 
 

During replay it is possible use the replay controls or the remote control to pause, change
playback speed, skip to next track etc.  At any point you can capture again. It is not necessary to
switch from Replay view to Live view to initiate capture.

5.2.2 Controlling the replay

Replay of the clip can be controlled by using the playback buttons like on a normal VCR, or by
using the equivalent remote control buttons (see Remote controlling InTheAction). Read the Getting
familiar chapter to learn the functionality of each button.
 

 

You are not restricted to replaying the last captured clip. Any of the previously captured clips will be
found in the Items List of the Library and Tray and may be reopened by dragging them into the
InTheAction video display window.

5.2.3 Remote controlling InTheAction

Because InTheAction is a tool for use during a training session you shouldn't be a slave to the
computer! Now is the time to install the remote control (see Remote controlling Dartfish in the
Getting fam iliar chapter) and learn to use its features. 
 

As has been emphasized several times in this chapter already, all commands covered in this
section can be executed by remote control:
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To use the remote control, its driver must be installed and the infra red receiver connected.
How to do for the different types of remote control as well as guidance on using their features is
covered in the Getting fam iliar with Dartf ish chapter.

The actual distance at which the remote can be used (max. 20 meters) is dependant on
environmental factors and how fresh the batteries are. Batteries are quick to run down if you put
the remote in a bag where the buttons get pressed by other contents.  Add spare batteries to
your Dartfish equipment inventory.

5.2.4 Using a sound trigger

Previous topics have indicated that capture using InTheAction can be triggered by clicking the 
Capture button and by remote control.  There is a third method for triggering capture; a sound
trigger that can be configured to react to, for example, a club or bat striking a ball, a starting
klaxon or even a voice command.
 

When using voice as a trigger, the sound trigger reacts to the volume, not the quality, of the
sound.  Therefore a voice command will only work if louder than other incidental noise.
 

To use the sound trigger it must be activated and then configured to respond to the correct
volume of sound.

 

Activating the sound trigger
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Before use, the sound trigger must be activated.  To do this:
 

1. Select Tools > Custom ize... from the M enu bar.
 

2. Select the Rem ote Control tab.
 

3. Tick the box next to sound trigger to activate it.
 

 

4. Close the Customize window.  It is not necessary to configure the trigger at this stage.

 

Configuring the SoundTrigger
 

1. From the menus select Tools > Conf igure SoundT rigger...
 

 

Hardware configuration.  The input device will generally be set to "Microphone".  It is not
possible to use the video camera as an input device for sound so your computer will need

to be equipped with a built-in or external microphone.
 

Detection configuration.  Select the profile that is a closest match to the type of sound

used as a trigger then adjust the Sensitiv ity slider to an appropriate level; where
incidental sounds do not trigger capture but the trigger sound does.  Both the hit counter
and the Sound Trigger Server Status will help you assess which sounds do and do not
trigger.

 

2. Close the Conf igure SoundT rigger Properties window.  The sound trigger is now active and
can be used as a method of triggering InTheAction capture.

5.3 Comparing clips during training

It may be beneficial to compare the last captured clip to a reference clip when working during
training.  You  have the choice to display both clips side by side, blended together or in a picture-
in-picture mode.
 

 

The steps to compare in InTheAction are to:
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1. Define (set) a reference clip.
 

2. Activate the Com parison view and capture a clip. The captured clip is automatically compared

to the reference clip 
 

3. If needed, synchronize the last captured clip with the reference

5.3.1 Setting reference

To Set a reference clip, proceed as follows:
  

1. Load a clip from the T ray or from the Library items into the InTheAction module
 

2. Click the Set Reference button found below InTheAction playback controls.
 

 You can use any other clip already saved on your hard drive as a reference clip. 

 

Viewing the reference clip
 

The reference clip can be viewed at any time by clicking on the Reference replay button.
 

5.3.2 Working with comparison view

To work with comparison view, click on the Comparison view button on the left edge of the
InTheAction module.  Comparison view is 

 

 

The screen display will be split in two,  the reference clip on the right and on the left the last
captured clip. Both clips will be replayed in function of the scenario that you defined (see Defining a

replay sequence).

 

To work with the Compare mode:
 

1. Capture a video clip. 
 

2. At the end of the capture, the clip is automatically displayed next to the reference clip.
 

3. Use the playback buttons to control the replay

 

To select the comparison layout:
 

Use the following buttons:
 

 Split Screen - where the clips will be displayed side-by-side.

 Basic Blend - both clips will be superimposed on top of each other.

 Picture-in-Picture - the reference is displayed in the corner of the replay clip.
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5.3.3 Synchronizing clips in InTheAction

In order to effectively compare two clips, obviously they must be showing comparable activities,
for example, you can't compare two divers if one is at a different point in the routine.
 

Synchronizing clips is often unnecessary with InTheAction because a synchronization point is set
when capture is triggered.  Provided that you always trigger at an obvious moment each time
you capture, clips will always be synchronized.

 

To change or set synchronization points
 

1. Activate the Replay view (see Capturing and replaying).
 

2. Find the moment on the clip that is to be the synchronization point.  Use the Play/Pause and
Fram e-by-Fram e buttons to do this.

 

3. Click  .
 

4. Repeat for the reference clip if necessary (use the Reference replay button to display the
reference clip).

5.4 Using drawings in InTheAction

The right-hand side of the InTheAction module has a range of drawing tools which can be used to
annotate  video images, assist with analysis or coaching.  The use of these tools is identical to
the Analyzer module's drawing tools and is explained in that chapter.

5.4.1 Drawing Library

One unique feature of InTheAction drawing tools is that it is possible to store up to nine sets of
drawings in the Drawing Library.  This allows you to reuse drawings from one InTheAction
analysis to another.  

Displaying the Drawing Library
 

1. To use the drawing library it must first be activated.  To do this:
 

2. Display the Dartfish options (F3 or Tools > Options menu).
 

3. Select the Advanced topics.
 

4. From the ITA Settings, select the Use overlay drawing repository option.
 

5. After applying the change, the Drawing library control will be displayed on the InTheAction
module as shown below. 

 

 

Using the Drawing Library
 

1. Select an overlay from the list (up to nine overlays are possible)
 

2. Add drawings to the video image
 

3. As each new video is captured, the drawings from the currently selected overlay will appear
on the video image.

 

Remember, at any time drawings can be hidden by clicking the Show/Hide drawing button.
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The Drawing library is one of the many features that Dartfish have added in response to
requests from our users but at the current time, this feature continues to be developed.  If the
idea of a Drawing Library is valuable for the way you use Dartfish then you can look forward to
further enhancements to this feature in future releases of Dartfish.

5.5 Self coaching with live delay

Live delay provides a completely hands-free way of reviewing video during training which makes
it especially useful for self-coaching. It simply delays the display on the computer screen of the
images that the camera continuously observes.  It's like a mirror but one that waits a predefined
number of seconds before showing your reflection.  Enough time for the athlete to finish a
routine, drill or exercise then assess how he or she performed.
 

For example, a coach might explain adjustments required using the range of InTheAction features
explained earlier in this chapter and then leave the athlete to practice, using Live Delay to confirm
the adjustment is being executed correctly.

5.5.1 Live delay settings

Before using live delay the camera should be connected and switched to it's camera mode.   The
InTheAction module is activated and video input set up as described previously (see Preparing

InTheAction for use).
 

To use Live Delay, you must determine the duration of the movement that you will review and
then add 1-2 seconds as a margin. For instance a Golf swing takes 3-4 seconds, it might take a
further 5 seconds to get to a position to view the computer display - you would then set an 11
second live delay (2+4+5).

 

Setting the amount of delay
 

1. From InTheAction's Recording Options change the live delay value.  The largest amount of
seconds you can set is related to the amount of available RAM memory of your computer.

 

2. Click on the Live Delay view button. 
 

 

3. Press F11 on your keyboard to have a full screen view (press F11 again to come back to
normal view).

 

That's it!  No button presses, no files recorded, no comparison, no pause or replay.  Just a
simple tool to help with self coaching.
 

 

Using live delay doesn't stop the use of other InTheAction features.  As soon as the capture
button is pressed/clicked, capture begins according to the pre-record and duration settings and
replay commences straight away. However, to trigger the capture, always refer to the live action
and not to what you seen on the screen.

5.6 Next steps

InTheAction allows you to review and compare performance while training takes place but to review
these performances at a later date you should learn how to load, synchronize and compare clips in
the Analyzer module.
 



78 Dartfish User Guide

© Dartfish. All rights reserved. - Version 7 -

The Analyzer module will also allow you to publish your clips into a media book; a remote coaching
tool complete with audio and text guidance (read the chapter on the Analyzer).



Chapter

VI

Unique ways to view sport
- SimulCam & StroMotion
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6 Unique ways to view sport - SimulCam & StroMotion
With SimulCam and StroMotion, Dartfish offers uniquely creative ways of observing, analyzing
and understanding sport.
 

Each creates images that can never be seen in real life; StroMotion allowing the athlete to leave
a clone of him/herself behind as he moves; SimulCam allowing two athletes to virtually
"compete" against each other when in reality their performances took place at different times.
 

You may have already seen these techniques in use because Dartfish provides this technology to
television broadcast companies around the world.  They use it to illustrate and give their
audiences a better understanding of sport and now you can benefit in the same way:
 

Perhaps SimulCam or StroMotion will be the only way that you can compare the tiny

differences between competitors; the tenths of seconds separating competitive skiers for
example, or subtle differences in a tennis serve.  

 

Perhaps the images will help teach technique to your development squad in a way that they

will have never seen before.
 

Or perhaps you will use the technology to inspire athletes by having them compete alongside

the great names of your sport!

6.1 Compare with SimulCam

The SimulCam technology provides you with a unique analysis capability for comparing two
athletes' performances blended onto a single background. This enables you to view and analyze
often imperceptible differences between these performances, and discover precisely what made
one performance stronger than the other.

To compare performances, SimulCam matches the backgrounds of 2 video images so that even
if the camcorder pans, zooms or tilts it continues to track the background features. Using this
information, the two backgrounds can be blended into a single one.

In essence, SimulCam has a similar purpose to using the Analyzer module's Basic blend view,
however the end result is vastly superior:  Basic blend is unable to track the relative movements
of the background features, making comparison near impossible if the camera zooms or pans
during filming.  Basic blend results in ghostly, semi-transparent figures whereas SimulCam creates
a more realistic picture. 

 Required to use SimulCam: 
  

Camera on tripod
 

Pan, tilt and zoom allowed during filming. 
 

Video clips can be recorded at different times but must be taken by a camera in exactly the

same position.
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The steps in using it are to:
 

1. Step 1 - clip selection and synchronization. Two video clips are loaded.  To be comparable the
two clips should then be synchronized.

 

2. Step 2 - camera movement calculation.  Background features are matched and the amount
of camera pan and zoom is calculated.

 

3. Step 3 - blending, preview and saving the clips. You can also save the SimulCam project if
you wish to make changes to any of these steps later. 

6.1.1 Getting good SimulCam results

Remember, the SimulCam technology matches backgrounds of two video clips; it will have
difficulty doing this under the following conditions:
 

Insufficient number of background objects
 

For example; snow.  Imagine trying to identify the same point on a white background from
frame to frame.  Your brain is still better than a computer's so "what the eyes cannot see, the
computer cannot!".
 

Avoid this by not zooming too closely on the subject.  Even on snow, shadows, rocks,

slalom gates etc can still be used but only if enough of these distinguishable objects appear in
each frame of video.

 

Background is blurred
 

Its the same problem, if background objects become blurred or out of focus, SimulCam is unable
to calculate where they have moved to. 
 

Use a tripod or another solid object to mount the camera.
 

Zoom and pan smoothly and slowly.

 

Backgrounds are different
 

SimulCam can only compare if the content of the background is similar in each video clip.
 

Always film from the same position.  If it helps you remember, mark the spot!
 

It does not matter if a different zoom has been used for each clip - the backgrounds only

have to contain similar objects filmed from the same direction.  SimulCam will calculate the
difference in zoom.

6.1.2 Step 1 - clip selection and synchronization

Step 1 of the SimulCam clip creation process consists of:
 

Loading two video clips containing the performances to analyze.
 

Synchronizing the clips for optimum comparison.
 

Trimming the video by selecting appropriate cue in & out points.
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6.1.2.1 Loading video clips

SimulCam compares two clips.  Drag & drop each clip you wish to compare from the items list on
to SimulCam's left and right video display windows.

At this point, you can exchange either clip for another clip by simply dragging and dropping a
different clip from the Item s list or T ray.
 

The video format must be DV (.avi), for example it is not possible to create SimulCam images
from Windows media (.wmv) video or MPEG (.mpg).  Also, the two clips cannot be of different
formats (for example, NTSC and PAL).

6.1.2.2 Synchronizing video clips

SimulCam has a set of easy-to-use tools to help you synchronize the two video clips. These
tools are located at the bottom of the SimulCam window.

 

To synchronize the video clips:
 

1. Click and drag the timeline cursor    until you see an easily identifiable moment in the first
video clip. For example, find the instant where a long jumper's foot hits the board, when a
skier passes a gate, when a golfer hits the ball etc.

 

2. Click and drag the yellow timeline (this represents the second clip) left or right until you see
the same image in the second video clip. 

Fine-tune the video frame selected using the left and right cursor movement keys of your
keyboard

It is important that you choose a starting frame with clear static elements that appear in both
backgrounds. This will help you align the backgrounds in the next step.
 

A "perfect" synchronization does not always yield a perfect analysis. The overlap between both
performers may be too high, hiding important details. In this case, try to add one or two frame
shift between both video clips.
 

If the video clips contain synchronization points, they are automatically synchronized when
loaded.
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6.1.2.3 Trimming the clips

This means selecting the portion of the video clips you want to analyze. This is done by setting
cue in and cue out points.

 

To set cue in & out points
 

1. Position the red cursor at the beginning of the portion and click on the Set In button (  ).
2. Position the cursor at the end of the portion and click on the Set Out button (  ).

It is worth taking time to trim the clip to the section of the video you wish to compare as this
considerably reduces the time taken to produce the final result clip.  Also, experienced SimulCam
users will be able to avoid sections of video where SimulCam is not able to make comparisons.

6.1.3 Step 2 - camera movement calculation

In this step, calculation of the camera movements is initiated.  This is required by SimulCam to
blend the two performances onto a single background.

In this process, similar features in the backgrounds of the two video clips are manually aligned by
one of two methods:
 

1. Drag & zoom  alignm ent - Backgrounds are aligned by blending the first frame of each clip
then zooming and dragging one frame above the other until backgrounds match.

 

2. M atched alignm ent points - Several matching static background features are marked with
alignment points on the first frame of each clip.

 

Which method is best?
 

We recommend that you try both methods to decide which one is most comfortable for you. By
default, your software uses the Drag & zoom  alignm ent method.  Use the following notes as a
guide.
 

In general, manual alignment by the Drag & zoom  alignm ent method is quicker.
 

Drag & zoom  alignm ent requires you to zoom using scroll function of your mouse or the [+]

and [-] keys of your numeric keypad (refer to your laptop documentation).  If neither of
these are convenient for you then M atched alignm ent points might be a better choice.

 

The M atched alignm ent points method is sometimes a better choice when the video images

do not match well.

 

To select the calculation method
 

The calculation method can be changed at any time before or during SimulCam.
 

1. Select Tools>Options from the menu bar (or press F3).
 

2. Select the Sim ulCam  topic from the list on the left.
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3. Select the mode.  Note that you can Set as default your choice of calculation method.

6.1.3.1 Drag & zoom alignment method

The Drag & zoom  alignm ent method consists of dragging and resizing the image of the first
video clip on top of the other clip until the two backgrounds match perfectly.  Step 2 using Drag
& zoom alignment looks like this:

Images from both videos are blended but the backgrounds still have to be aligned for each of the
3 pairs of images displayed on the left hand side of the module.

 

Adjusting Zoom
 

If the camera used different zoom while filming the two video images this can be compensated
for by resizing the top video image.
 

1. Click the blended video images.
 

2. Adjust the size by using the mouse scroll function.  

If your mouse has no scroll function or it does not operate zoom then use the [+] and [-]
keys on the numeric key pad of your keyboard.  Different laptops use different methods of
activating and operating the numeric keypad; refer to your laptop's manual to find out.

 

Aligning backgrounds
 

When images are a similar size, they can be aligned - although you may have to align then zoom
again to get a perfect match.
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1. Click & drag anywhere on the blended video images, the top image will move over the image
below it. 

 

2. Focus on one or more objects in the background; the stands, objects on the field, posts,
equipment, etc. and align those objects. 

 

Repeat Alignment for the other pairs of images
 

The first pair of images show the background of the two different video clips.  The alignment
process needs to be repeated for the two remaining pairs of images.  These pairs are used to
calculate movement from one frame to the next in each clip so if movement is slight this will be
much quicker than aligning the different video clips.
 

1. Click the second pair of images listed on the left hand side of the SimulCam module.
 

2. Align them.
 

3. Click the second pair of images listed on the left hand side of the SimulCam module.
 

4. Align them.
 

The end result of step two is illustrated below.  Click the Next button to proceed.

6.1.3.2 Checking alignment

Check the alignment quality using the transparency cursor.  

Drag the cursor to the left and to the right. If you feel that the background is moving, it means
you need to keep aligning the two backgrounds.

 If you still cannot align the background, after repeated zooming and alignment, this could
mean that the camcorder tripod moved during your recording session. In this case, it is not
possible to create SimulCam video clips. You still can compare performances but you will need to
use the split screen functionality of the Analyzer module.
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6.1.3.3 Matched alignment points method

The M atched alignm ent point method is a process of placing markers on similar features in the
background of both video clips.  The alignment point window is illustrated below:

 

Selecting background alignment points.
 

In this method, at least two points are set on objects in the background of the first image and
then set on the same objects on the second background.  This is repeated for all three pairs of
images listed on the left hand side of the SimulCam module.  It is best to use obvious points of 
high contrast as illustrated in the following pictures:

      
Also it is essential that these background points are fixed objects:  People or the top of the
slalom gate in the above clip would not be good choices because they move!

 

To define alignment points.

1. Click on the first clip's title above the video display.  A frame of the first clip is displayed in the
main screen. (Ski 1 in the illustration below)

2. Click the left mouse button on a static background feature. The feature is marked as shown
below.

3. Now click a second and perhaps a third object.  They will be labeled similarly;  you must set a
minimum of two alignment points but defining more may improve the background alignment.

 

4. Click on the second clip's title above the video display. A frame of the second clip is displayed.
 

5. On the second clip, click the same background objects that you selected on the first clip in
the sam e order so that the num bers m atch; the thumbnail on the left displays the previous
selections and can act as a guide.

 

6. Click on Visual Check on the process bar. A combined image of both frames is displayed. The
backgrounds should appear aligned.
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If you need to delete a numbered mark because the elements are not in the second image

or are not positioned correctly, right-click on the mark you wish to delete. Then left-click in
the correct position and a marker with the same number appears again.

 

If the backgrounds do not match in the Visual Check, make sure that the alignment points

are placed correctly and that point 1 matches point 1 in each image etc.  If backgrounds still
do not match then adding further points will improve accuracy.

 

7. Select the second pair of images from the thumbnails on the left of the SimulCam module.
These images compare camera movement form one frame to the next in the same video
clip.

 

8. This time feature points are already set but you need to check they are positioned correctly.
Use the techniques described in step 6 to remove and reposition feature points as required.

 

9. Repeat for the third pair of images.
 

10.When complete proceed to the next step by clicking on the Next button.

6.1.3.4 Adding new alignment frames

Both methods to complete step 2 require that you match the backgrounds in the starting frame
of your clips. However, if the backgrounds in this frame are too different,  they do not include
clear common background elements or the objects are blurred you will need to set a different
start frame.

 

To set a new start frame.
 

1. Go back to step 1 by clicking the back button.
 

2. Set a new cue in at a start frame that is more appropriate.
 

3. Repeat step 2.

 

Setting new alignment frames.
 

It is essential that the start frames match but additional frames can be set where backgrounds
can be realigned.   This might be necessary for clips that "jump" because of a change of camera
angle, or because the images have become blurred during panning or the clip does not include
part of the action in a particular frame.  
 

New alignment frames are represented by flags in the timeline. Once you add a flag, you will be
able to realign the backgrounds in that particular frame as described previously.

 

To add a flag.
 

1. Go back to step 1 by clicking the back button.
2. Drag the current position indicator    along the timeline to the new alignment frame.

3. Click on the Add f lag button   . A new flag is added to the timeline. A red flag indicates that
the background alignment still needs to be performed for this particular moment

4. Other icons allow you to jump to the next or previous flag and to delete a flag.

5.  Repeat step 2 for each flag added.
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6.1.4 Step 3 - blending, preview and saving

Step 3 enables you to: 
 

Select the blending mode
 

Start the calculation of the SimulCam clip and watch a preview
 

Save the SimulCam video clip

6.1.4.1 Blending mode

The SimulCam image quality may vary depending on the blending mode. You can choose from
three modes and use the preview to experiment with what works best for your sport.

1. M otion-based: In most cases, this is the best mode to use for generating a blend. It is based
on the camera movement.

 

2. Color-based: Use this mode when your clip features a lighter colored background than the
performer. For example, snow, sand, concrete.  Light colors are "pushed" into the
background.

 

3. Constant: This is the fastest blend calculation mode, however, the resulting quality is poorer
than the other modes. Use this mode when you want to get a rapid result.

 Use the drop-down list to select the blending mode

6.1.4.2 Previewing your clip

It is not necessary to use the preview function but it will help you decide the best blending mode
and whether additional alignment is needed.
 

To preview, click on the Start preview button. The SimulCam clip will be displayed in the main
screen as the calculation progresses. At any moment, you can decide to stop the calculation by
pressing the Stop preview button. You can now experiment with different blend modes to
compare which gives the best result.
 

If the SimulCam can be improved, go Back to the previous steps and redo cue in, alignment,
blend mode etc. 

This done, it may be that there is still a progressive misalignment of the backgrounds. If this
happens, stop the preview and try one of the following.
 

1. Add an alignment flag to the frame where the background misalignment begins (see  Adding
new alignm ent fram es).

 

2. Select a different first frame - as described in Step 1.

 

It is much quicker to preview using Constant Blending m ode.  When satisfied that alignment is
correct switch blending mode to M otion-based or color-based for a better quality result.
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6.1.4.3 Saving SimulCam results

There are two potential end results of a SimulCam project: 
 

the creation of a new video clip using the Publish process
 

the SimulCam project itself.

 

Saving the SimulCam project
 

To do this select the Save... option from the F ile menu. Saving the project is not always
necessary but may be useful if you wish to return to the project to make changes in the future. 
SimulCam projects appear in the Item s List represented by the following icon:
 

 

Starting a new SimulCam project
 

To initiate a new project select the New option from the F ile menu.

6.1.5 Publishing new video clips

The publish process uses a wizard to guide you through creating new video clips resulting from
SimulCam, SimulCam Fixed, Stromotion and Stromotion fixed.  It is used to:
 

Save and name the video clip.
 

Categorize the new clip using categories.

Initiate the Publish process by clicking the Publish button at the bottom right of each module.

6.1.5.1 Choosing video settings

The first step is to select which encoding profile you wish to use for the clip.  A range of encoding
profiles exist to allow you to select an appropriate format for the eventual use and location for
the video.  For example, if the video clip is lengthy or needs to be sent by email, you may decide
to use an encoding profile which compresses the result into a file of smaller size (see Converting
video in the Getting Familiar chapter to learn more about video settings).
 

After selecting a profile, click the Next button to continue.

6.1.5.2 Assigning file name, destination and categories

File name
 

Type a name for the video clip in the F ile Nam e text box.  If this box is left blank the generic
filename of "Untitled" will be applied.
 

Categorize clips while saving
 

If you use Dartfish's Keyword video management system (see Organizing your library in the
Video Library chapter) then you can benefit from categorizing new video clips as they are saved.
The method for doing this is to create a form listing a box each category that you wish to use
then selecting existing keywords from these categories or entering new ones.  An example is
shown below.  The same method is used for categorizing captured video.
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Destination folder
 

This is the physical location on the computer (drive and folder) where the new clip will be stored.
Type the location or click the Browse button to search and select a folder.

Conflicting file options
 

If the file name matches that of another file in the destination folder the  conf licting f ile options
setting allows a choice of overwriting the original file or renaming the saved file.  If the latter
option is chosen, the new video file will be suffixed with a number.  For example, if "World cup"
already exists a new file would be called "World cup(1)".

6.1.5.3 Video creation

The final step automatically initiates the creation of the new video file according to the settings
chosen in the wizard's previous steps.  The time taken to render the new video will depend on
the power of the computer and the size of the new file; progress of creation is indicated.
 

You will be notified when the publishing process is complete and, by default, the new video clip will
be added to the T ray, allowing convenient access to replaying it in the Player or Analyzer
modules.

6.1.6 Next steps

SimulCam & SimulCam Fixed are unique analysis capabilities for comparing two athletes'
performances blended onto a single background.  You may also be interested in the following
topics:
 

Read the topic StroMotion for another Dartfish special effect enabling you to dissect motion

of a performer in a panoramic still image or a video clip.
 

The Analyzer module offers another way of highlighting key frames and uses them to

bookmark these moments and turn them into still images (read the chapter about the
Analyzer to learn more).

 

Having created these unique images, you may want to share them by CD, email or internet

(see Sharing video files in the Video Library chapter).
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6.2 Dissect motion with StroMotion

Images produced by StroMotion give an athlete and coach unique insights to how an action
develops.  It produces a panoramic still image or a video clip that contains collections of frozen
images, revealing how rapid technical changes are made.

To imagine how this might help you, think of times when it might be useful to show your athlete
their position on one frame of video then show it's consequences in another frame.  How about
educating your junior team about the correct sequence of actions to use?  Sure you could print
out some still pictures but StroMotion offers a juxtaposition of images which truly reveals how
one action leads to the next.  

    

The process of creating a StroMotion clip involves 4 steps:
 

Step 1 - Load & trim the video clip
 

Step 2 - Camera movement computation
 

Step 3 - Panorama reconstruction
 

Step 4 - Draw clones & save results
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6.2.1 Step 1 - Load & trim the video clip

Loading the video clip
 

Open the clip of your choice from the items list or tray.

The chosen clip may be changed by simply loading a different clip.

Trimming the clip (set cue in & out points)
 

The clip should be trimmed at the beginning and end of the movement that is to be turned

into a StroMotion image.
 

Choose a start position with clear background features.  This will help you match background

features in step 2.

 
Click the Next button at the bottom right of the StroM otion module to proceed to the next

step.

6.2.2 Step 2 - Camera movement computation

In step 2 camera movement is calculated.  This is initiated by matching at least two background
features in successive frames of the video clip by setting alignment points.  StroMotion then
computes the movement of the camera throughout the clip.

The points set as alignment points should be static, people are not a good choice of alignment
point! They should also be obvious points in the background as StroMotion can't track the
objects if they are blurred or similar in colour to the surrounding background. 

 

To set alignment points
 

Click the left mouse button while pointing at an object (a flag, center line, pole, goal, etc.)

that is present on both frames
 

The red alignment point which appears is labelled with a number.  The same marker will

appear on both images.



93Unique ways to view sport - SimulCam & StroMotion

© Dartfish. All rights reserved.- Version 7 -

 

To exactly position alignment points on features, zoom in on that feature. To do this click the
mouse on the feature while holding down the [ctrl] key on the keyboard (Left-click to zoom in
and right-click to zoom out)

 

To adjust alignment points
 

In the image above the feature point labelled "2" is not marking the same place in both images. 
To correct this:
 

1. Right click on the incorrectly positioned alignment point to delete it.

2. Then left click the position where the alignment point should be.

Repeat this setting and adjusting operation until you have selected at least two alignment points

You can check how well the alignment points match by clicking the Visual Check button.  A
window opens showing the athlete moving against a static background. If the background
appears to move or shift, you should check your alignment points or add further points until the
background is relatively stationary. 

 

Calculate camera movement
 

Click the Start button.  Shading inside the timeline shows how much of the process is

complete.
 

When the calculation is complete, you are ready to click the Next button to go to the next

step.

The Show warping button allows you to check the result while the clip is being processed.  If the
background appears discontinuous as it is constructed , stop the computation and make further
adjustments to the alignment points. This may also be caused by the tripod moving during
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filming.

6.2.3 Step 3 - Panorama reconstruction

Usually no action is required in step 3 as the panorama reconstruction begins immediately.
 

1. If it doesn't start then click the Start button.  As before, timeline shading will show progress.
 

2. Click the Next button to proceed to the next step.

6.2.4 Step 4 - Draw clones & save results

This step is where you select the parts of the image which will stay fixed on the subsequent
frames of video and will appear as "clones" on the panorama image.  To do this you will:
 

1. Identify key frames in the video clip where the performer or object is in a position of interest.
 

2. Draw around the "clone" object using a range of clone drawing tools.
 

3. Repeat the above for all key frames.
 

4. Save the project, result clip or panorama image

6.2.4.1 Identifying key frames

Your task here is to find frames of video showing the athlete (or another object) in a key
position of interest.  This is the moment of action that you wish to freeze.
 

You should already be familiar with how to use the timeline to move through a video clip.  It is
worth remembering to use keyboard shortcuts [ctrl] + [left/right] cursor keys that will play one
frame at a time and fine-tune your selection (read the Getting Fam iliar chapter to learn more). 

to insert clones at a fixed interval use the Jum psize control illustrated below to define the size
of the "jump" and move backward and forward through the clip by this interval.

6.2.4.2 Drawing clone objects

Having found a key frame of video - one in which an athlete or object is in a position of interest,
that athlete or object now must be cloned.  You are not restricted to cloning a single object, so
select all objects of interest in each key frame.

The objects or athletes that you want to clone are drawn, selected and manipulated using the
tools on the right of the StroMotion module.

 Select tool - select clones or move selection.

 Rectangular clone tool - clone creation tool.

 Freehand clone tool - freehand clone creation.

 Delete selection - deletes the performer/object selected by the select tool.

 Delete all - deletes all performers/objects on this frame.

 Zoom  in/out - zooms in on the point on the image that is clicked (right click to zoom out).
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To create clones
 

Use the Rectangular clone tool or the Freehand clone tool tools to "draw" around the performer/
object to be cloned.

To use the Rectangular clone tool 
 

1. Click the Rectangular clone tool button.
 

2. Then point the mouse above and to the left of the object to be cloned.  
 

3. Click & drag downwards and to the right until the selection box encompass the object while
including as little background as possible.  

To use the Freehand clone tool
 

1. Click the Freehand clone tool button
 

2. Click & drag around the object staying as close to the edge as possible. 

If you miss part of an object during
selection,  don't delete the clone and start
again, simply include the missed part as a
new selection. More than one tool can be
used and more than one selection can be
made to create a clone as shown in the
image below.

 

Which selection tool is best?
 

To answer that, remember that whichever tool you use, the selected area will stay fixed on the
video image.  If there is overlap between clones, the later clones will obscure the earlier ones.
 

Use the freehand tool when there will be a lot of overlap between the clones.  For example in

a gymnastic rings routine or high jump.
 

Use the rectangle tool when the clones will be spread out - the performer moves some

distance between the key frames.  For example in long jump.
 

To edit clones

1. Select the clone to edit by using the Select tool  . Click the tool then click the outline of the
cloned area.  

2. Selected clones can be deleted , moved by click & drag, or reshaped by dragging the
"handles" at each edge or corner, see these illustrated below.  All clones in a frame can be

deleted using the   tool, it is not necessary to select clones first to use this.
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By zooming in on the image  more careful selection is possible.  Click the left mouse button
to zoom in and the right mouse button to zoom out.

6.2.4.3 Publishing StroMotion

Creating StroMotion results is done using a Publishing wizard almost identical to that used by
SimulCam.  It is initiated by clicking the Publish button in the final step of StroMotion and
StroMotion Fixed projects.

Publishing can produce a choice of two results described below. After selecting an output type
and clicking the Next  button, the remaining steps are described fully in the SimulCam chapter
(see Publishing new video clips in the Simulcam chapter).

 

StroMotion still image
 

A bitmap (.bmp) picture of all clones superimposed on the background.  If a panning camera was
used, clones are superimposed on a panoramic background image.  An example of this is shown
below.
 

 

Although bitmap and jpeg images will appear in the Item s List, no Dartfish modules are used to
display them; if opened from the Item s List they will actually be opened using default Windows
image display/editing software on your computer.

 

StroMotion video
 

The original video has each clone appear and remain on the video image as the movement
develops.

6.2.4.4 Saving StroMotion

It is possible to save a Stromotion project if you wish to return to it to make adjustments or
publish it's results later.  StroMotion projects are represented by the following icon in the Item s
List.
 

 

Save the settings used to create the project by selecting Save as... from the F ile menu.
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6.2.5 Next steps

StroMotion & StroMotion Fixed are one of Dartfish's special effects allowing you to view
movement in unique ways.  You may also be interested in the following topics:
 

Read the topic SimulCam for another Dartfish special effect enabling you to place two

performers together in the same place and time.
 

The spline drawing tool (see chapter on Analyzer) is another way of tracking and illustrating

movement.
 

The Analyzer module offers another way of identifying key positions and uses them to

bookmark these moments and turn them into still images.
 

Having created these unique images, you may want to share them by CD, email or internet

(see Sharing video files in the Video Library chapter).





Chapter

VII

Tagging Video
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7 Tagging Video
Traditionally, reviewing sporting performance on video is a linear process – you rewind the tape,
press play and observe the action as it takes place. Of course your camcorder's fast forward
button saves time but finding and replaying important moments in the game or competition
essentially remains linear – and slow.
 

Imagine how useful it would be to be able to mark and label these events on the tape as you are
filming because you could later jump between these marks in any order you choose. You could
review only the events of interest and choose to see related events:  "Let me look at all the
times our opposition scored" ceases to be a lengthy process of fast forward and play.
 

Dartfish's Tagging module doesn't physically mark a tape but instead brings digital video onto the
computer and allows you to create a searchable index of the video content. Each event is tagged
with not just one label but a set of keywords that really identify what is happening. This process
not only lets you search and review these events but compiles match statistics:  "Which shot
does my opponent most often score with?" is not only a question that can be easily answered,
but the relevant shots can be replayed and analyzed.
  

A short history of tagging
 

If all this sounds familiar, that is because Dartfish Tagging is a combination of long-used tactical
analysis methods:
  

Notational analysis - the coach or analyst sits on the sideline with pen & paper ticking off or
coding events as they take place in a game. Tagging does this using buttons which are clicked to
code events.
 

 Video indexing - even before digital video, coaches attempted to make it easier to find useful
moments in the video of the game by noting the time that they took place. This made it easier
to fast forward to that point on the tape but it's easier still with Tagging; the events you code are
listed in an index which can be searched and displayed non-sequentially.

 

Is Tagging just for Team sports?
 

No. While other Dartfish modules are used for technical analysis of isolated events. Tagging is
more about a tactical analysis of the game as a whole while being able to focus on specific
moments of choice. It is therefore useful for any sport where these qualities are of interest: 
Team sports, racket sports, combat sports, skating/gymnastic routines etc.
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7.1 What is Tagging?

Tagging is the action of creating a video index, a list of Events that occur in the video. Consider
for example a video that contains a soccer game; the video index could look like this:

Index Position Duration Event TypePlayer Team

Event #1 23 s 7 s Pass Defender Team A

Event #2 1 min 13s 7 s Free kick Striker Team B

... ... ... ... ...

The Position corresponds to the time in the video when the event occurred. 
 

The Duration is a portion of the video when the events take place.
 

Event type, Pass and Team are Categories. Pass, Defender and Team A are the keywords in

each category.
 

An event is fully defined by the Position, Duration and the categories' Keywords. It can be

illustrated as follows:

Once you have created your index, you will be able to retrieve particular events. For example,
you may want to retrieve events that match the following criteria:
 

Team  = Team  A, i.e. all events of Team A
 

Event T ype = Pass and Team  = Team  A, i.e. all the passes of Team A
 

It is important to be aware that the Tagging module doesn't just tag instantaneous events such
as these examples, lengthy sections of video such as a team's ball possession can be tagged at
the same time as the passes and free-kicks taking place during that possession.

7.2 The Tagging Workspace

To launch the Tagging module, click on the Tagging icon in the icon bar, or select Tools >
Tagging from the menu bar. 

The module workspace is illustrated below:
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It is composed of four different elements (clockwise from top left):
 

1. The Library (more precisely the T ray of the library), which opens a collection of video clips to
be tagged or reviewed.

 

2. The Video Panel, which contains the video display and the different video controls which let
you capture and replay video. This also has controls to display and hide the other panels and
select the video source.

 

3. The Tagging Panel, which contains a set of buttons and other tools; some of which create a
timestamp for each event and others which describe the event with values.

 

4. The Events List, which contains the list of events, i.e. your video index.  It also has features
related to the management of  events; editing, searching and import/export functions. 

These elements are described in more detail in the remainder of this section.
 

When you launch the Tagging module for the first time, the workspace may not look like the
one illustrated above. If any of the four elements are not visible they may be displayed by using
the Views Bar buttons at the top right corner of the video panel (see The Video Panel).

7.2.1 The Library

It is likely that your tagging analysis will based on more than one file.  Perhaps different periods of
the game were recorded as separate video files or perhaps you are reviewing the video of an
entire season.  Dartfish offers you a simple way of working with as many video clips as you
require.

Loading all the clips you wish to analyze into the T ray section of the library allows you to:
 

See events from of all clips contained in the Tray;  allowing the events of many videos to be

analyzed together.
 

Search for events from all video clips within the Tray.
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View or tag multiple video files as if they were a single clip.

When working with multiple clips, it is useful to know that the video clip highlighted with a green
triangle is the one currently being played or tagged and that the Player's repeat options can be
used to play each clip continuously as a single movie (See Video playback in the Getting Fam iliar
with Dartf ish chapter)

7.2.2 The Video Panel

The Video panel is illustrated below.

Mode bar

The Mode Bar at the top left of the video display enables you to choose between two tagging
modes and a video player mode.

Tag Live mode records a video stream, at the same time as allowing you to tag during

capture. The screen and the different settings are identical to the Video Recorder module
(see Video Recorder: capture a video stream in the Video Im port chapter)

 

In the Tag Video Clip mode allows you to play entire video files that exist on your hard disk.

The clips can be tagged during playback  
 

The Play Events mode allows you to play back the selected events from the Events list
 

These last two modes use the video playback controls illustrated above. Read the section Video
Playback  of the Getting fam iliar with Dartf ish chapter to learn about the different controls.

 

Views bar
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The Views bar is found at the top right of the video display.  Its buttons show and hide the
different parts of the Tagging module. The buttons' functionalities are:
 

 show/hide the Tagging Panel
 

 show/hide the Events list
 
 

 show/hide the Library

Use the maximized workspace view (keyboard shortcut = F9 to simplify the screen
layout then show or hide these features as you need them.

7.2.3 The Tagging Panel

The Tagging Panel contains the tools to tag (or create the events index) of a video.  It is also
used to 

Access the tagging panels provided with Dartfish

Open panels created by you, sent to you or downloaded from www.dartfish.com; 

Create or edit new panels.

The Select button 
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The select button is used to open tagging panels which you have created or those which you
have been given.  Select also gives access to the built-in panels and to create new panels to
meet your specific needs (see Creating Tagging Panels).

Tagging panels are saved as files just like Word documents or Excel spreadsheets.  In other
words, they exist independently of Dartfish software, they can be saved and organized using
Windows file management, and can be attached to emails to be shared with others.

The Edit button
 

Opens the tagging panel editor.  A tagging panel must already be open before the edit button can
be used.

The tagging panel
 

Although Dartfish tagging panels allow great flexibility and creativity in how they can be used, the
tools on them principally have one of three functions:

1. Event tools - used to create events by time stamping the event and assigning it a descriptive
value

2. Keyword tools - used to add additional keywords to events

3. Grouping tools - used to organize other tools into groups; either to improve the layout
visually or ergonomically or to confer shared features on the group

 

Tagging panels can consist of one or more pages, accessed by tabs.  Buttons and tools for use
at different times in the tagging process are placed on different pages to improve the ergonomics
of the panel.

7.2.4 The Events List

The Events List contains the list of all events for all video clips in the current T ray: 
 

Events are selected by clicking on the row containing them. The video playhead moves to the
start of the event. Double-clicking an event both plays it and places Dartfish tagging in its Play
Events mode.

Selected events may also be:
 

Deleted using the Delete button 
 

Analyzed in Dartfish's Analyzer module (Storyboard button) 

Exported as .csv files using the Im port/Export button 
 

Published as new video clips that can be stored on your hard drive (e.g. to make a highlights

movie using video editing software) or directly burned onto a CD or data DVD (e.g. to give to
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team players or coaches), or uploaded to your dartfish.tv channel using the Publish Events
button.

 

 

 

Sorted by clicking on the column heading you wish to sort.
 

Searched and filtered.  See Search to retrieve specific events for more details.

7.3 Creating Tagging panels

To create a new tagging panel, proceed as follows:
 

1. Click on the Select button and choose New from the context menu.
 

 

2. Click on the New Panel icon
 

 

3. Select from the list of new project types.  Create a new Blank Panel if you wish to start with
an empty panel OR base a new panel on one of the built-in tagging panels.

This displays the Tagging Editor window as shown below

We recommend starting by using one of the Dartfish built-in tagging panels. Change
labels and add/delete buttons as necessary for your sport.

The Tagging Panel Editor
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The tagging panel editor has 3 sections, (left to right as displayed above):

1. The ToolBox contains buttons and other tools used to create and describe events.  They are
added to your tagging panel by drag and drop.  

2. The Tagging panel editor.  This is where the content and layout of a tagging panel is defined. A
new blank tagging panel already contains a tab group box allowing you to create a multi-page
panel if required.

3. The Properties pane. Properties are used to define the appearance and actions of tagging
panel tools

7.3.1 Adding/deleting/moving/copying tools

To add a tool to a tagging panel

Items are placed onto the tagging panel editor by dragging and dropping them from from the
Toolbox. 

New panels always have a tabbed group box with a single page, as show below.  In order to
place the tool on that page, it should be placed in the area denoted by the red line shown here:

Adding subsequent items also requires care, in the image below, new tools should be placed on
the gray shaded area if they are to appear on the same page as the other buttons.
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If placed below the page then that tool will be visible from all pages.

To move an item

Drag and drop the item you want to move to the new position.

To move a panel layout tool (group boxes etc)

1. Click within the panel layout tool (but not on any button or other tool)

2. A red outline surrounds your selection - use this to identify that you have the correct tool
selected

3. Click and drag the panel layout tool to a new location

It is not possible to move a group box to between other group boxes.  Instead it should be
moved above or below the other group boxes which can then be shuffled further to achieve the
desired position.

To delete an item

 Right-click on the item and select Delete from the context menu.

To copy an item

Drag and drop the item while holding down the [ctrl] key on the keyboard.  Release the item
before releasing the [ctrl] key.

Many tools will have similar properties so creating one button, defining its properties
and then copying it can be a very efficient way of creating a tagging panel.

7.3.2 Modifying properties

Items which have been added to the Tagging Editor have their appearance and function modified
by changing properties in the Properties panel. There are two types of properties; properties
which can take any value and properties which must take one or more fixed values. The
methods for modifying these two types of property are described below:

A complete description of properties can be found in the topic Properties list

 Modifying 'any' value properties.
 

1. Click on the tool. This will display the properties for that item.
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2. Click and type in the second column of the properties list to add or modify values.

 

Modifying 'fixed' value properties.
 

1. Click on the tool. This will display the properties for that item. 
 

2. Clicking in the second column of the properties list will allow you to select a value using the
buttons that appear. It is not possible to type values. One of two types of button are used:

 

 - selects or creates property values from a dialog box e.g. shortcut key property
 

 - selects property values from a drop down list e.g. style property

In the example shown below these buttons are shown as they would appear in the properties
panel. Properties such as Shortcut Key, Preroll and T rigger are selected using . Properties such
as Style are selected using , and properties such as Category, Value and Label are typed.

 

Double clicking the property heading in the column on the left is a shortcut to editing
properties.

7.3.3 Planning a tagging panel

Example of a basic Tagging Panel:
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Which events do you want to tag in your sport?

Creating tagging panels requires a clear idea of what you want to tag and how you want to
define the events' durations and the keywords which describe them.

One definition of an event could be "a segment of video".  You need to decide what are the
different types of video segments that you want to denote. Those events are likely to be key
moments or highlights within the video.

Many events in your sport or activity are easy to define but perhaps others are less easy,
consider this example:

In soccer, ball possession in the opponent's half is a key moment that might be tagged as an
"attacking possession". That possession might end in an attempt to score.  So do you want to
tag two events (attacking possession and attempt) or one (attacking possession; outcome =
attempt)?

There is no right or wrong answer to this; your decision will be based on what you want to
review; tagging this as two events gives you the capacity to choose whether to review attempts
separately from attacking possessions.

From this example it should also be clear that Dartfish allows you to tag events which coincide or
overlap.

Which of these events have a fixed duration (e.g. actions) and which are of variable
duration (e.g. game phases)?

Dartfish can create 2 types of event.  

1. Those where the duration can be predicted so only require a single button click to create an
event with fixed duration.

2. Those where the duration of is not predictable and is defined by clicking a button on and then
off.  

Regardless of how the event duration is defined, it is editable after creation.

How will your events be categorized?

The events list is a table made up of rows and columns. Each row contains the keywords which
describe the event and at the top of each column there is a heading which describes the category
of information displayed in that column.

When categorizing events you may choose to simply list all events under a single heading such as
'Action' in the example below:

Or you may decide that your events fall into different categories such as 'Set piece plays', 'Open
play', 'Phases', 'Possessions' etc.

Placing all events into a single category keeps things simple, but using different categories offers
flexibility when it comes to filtering the events list and creating statistics.

It is not possible to simultaneously create multiple variable duration events (i.e. those created
using the continuous event tool) with  the same category.  If this is required, it is essential that
different categories are used.  For example, Team A might have possession but if there are to be
different phases of play within that possession then these events should be categorized
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differently e.g. 'Phase' and 'Possession'.

How will you describe these events?  Events are described by assigning keywords to
them.

Creating an event automatically adds 3 keywords; the video position, the duration of the event
plus one user-defined keyword.  Further  keywords can be added to more completely describe
the event so you need to consider what additional categories of information are needed.  For
example: 'Player' and 'Outcome' might be categories of keywords need to fully describe an
'Attempt' event.

What Keywords are required for all events?

It is very common that you will be tagging or reviewing the tags from more than one video file as
described in the topic The Library. In this case the same keyword should be added to all the
events of each file to allow you to easily distinguish which events belong to which file.

For example, if you create 2 video files for the first and second half of the soccer game, it would
be a good idea to have a category in your events list headed 'Game period', containing the
keywords '1st Half' and '2nd Half' to allow you to distinguish between events which took place in
the first video file and the second.

Ready to start creating a tagging panel?

Having thought carefully about the questions above, you will have a list of events and a list of
keyword categories.  No doubt you have also have some ideas about the keywords which
should go into each category.  Now you are ready to turn those ideas into a tagging panel.

7.3.4 Panel layout tools

Group boxes

These tools organize the layout of a panel by grouping buttons together.  So unless you have a
very simple tagging panel, group boxes are likely to be the first tools that you will add to a new
tagging panel. They have two functions:

1. To organize the layout of buttons on a tagging panel.

2. To set the category property of many buttons simultaneously i.e. tools placed into a group
box inherit their category from it.

This is an efficient way of ensuring the category property of buttons is not omitted or
inconsistently applied.  However it is possible to over-rule the inherited category simply by setting
the property of the individual tools.

If you have already read the topic Planning a tagging panel, you should have a good
idea of what categories your events list requires. Start your new tagging panel by
adding a group box for each category and set the category property of each to each one
of your categories.

Nesting group boxes

It is possible to place group boxes inside another group box.  In the example below, group boxes
have been used to organize the layout of players on a soccer pitch.
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In this image, 'Players' is the selected group box and the red line indicates that it contains the
other group boxes.  Its category property is set to 'Players' therefore the other group boxes and
any buttons placed in them inherit this.

Tab group boxes 

The pages of a tab group box each behave like a group box, the contents of which are only seen
when the tab of that page is selected.

The advantages of a tabbed group box are:

They are a very space efficient way of including many buttons on a tagging panel.

Panels can be created to only show buttons which are relevant to the current event;
simplifying the panel and guiding the user to appropriate tools.

Use the trigger property of a button to automatically select a tabbed group box page.
 Examples of this method to display relevant buttons as they are required can be seen in
most of the built-in tagging panels.

Adding tabs to a tabbed group box

In the tagging panel editor, new pages are added to a tab group box by clicking the last tab
showing the new page icon.  The new page displays the label [...] until an alternative label
property has been set.

Panel layout tool properties

Property Description

Label The text which is displayed on the tab.

Visibility The visibility property is a way of concealing tagging tools when the  user is
not required to use them directly. Other tools can be used to trigger the
contents of a hidden group box even when not visible.

Orientation Defines whether the contents of a group box are stacked vertically or placed
horizontally within a group box.

Image An image can be placed as a visual label for the group box.  It will be resized
to fit next to any text label

Category The category of a layout tool sets the category of any other tool it contains.
 Inheritance can be over-ruled by setting the category of individual tools
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7.3.5 Event creation buttons

Event creation buttons are used to add events to the Events List. The action of these tools is to
create an event described by:

Position - the timestamp of the start of the event in the video clip

Duration - how long the event last for

Keyword - the event is described by a single user-defined keyword.  The event can be more
fully described using Keyword addition tools after the event is created

Name - the filename that will be used if the event is exported as a video clip.  This will be the
based on the event keyword but can be modified.

Event buttons

The difference between Event buttons and continuous event buttons is how they define the
duration. Event buttons are used to create events with a fixed duration e.g. a tennis serve might
take around 5 seconds to prepare, deliver then witness the outcome. A single click on this type
of event button records the event. 
 

 

Continuous event buttons

Continuous Event buttons are used to create events where the duration cannot be predicted, e.
g. a whole point in a tennis game or an attacking phase in soccer. This button is clicked "on" and
"off" as the event starts and ends.
 

Continuous events are also switched off by activating other continuous events with the same
category property.  For example, this allows you to define the change in possession from one
team to another with a single click.  This improves the ergonomics of tagging but it makes the
categorization of continuous event buttons important:  if two continuous events are to run
concurrently then they must have different categories.

Important event creation tool properties
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Property Description

Label / keyword properties These properties define the keyword to be recorded in the events
list. Where the keyword property is not set, the label on the button
will be used as the keyword.  By setting these properties to different
values, it is possible to tag a different keyword to the text displayed
on the button. 

Category property Defines the column of the events list where the keyword will be
added. Without a category property the button won't record its
keyword.

Duration For event buttons only; this is the fixed duration of the event

Preroll Defines the number of seconds before the button click that will be
included in the event.  

For example when a shot is made, the button is clicked but you want
to define the start of the event 10 seconds prior to this in order to
see the action leading up to the shot. 

An event button with a 10 second preroll and a 15 second duration
would define an event starting 10 seconds before the button click
and ending 5 seconds after.

Offset start For continuous event buttons only; the equivalent of preroll. 

A negative value defines the event start prior to the button click and
a positive value defines the event start after the button click.

Offset end For continuous event buttons only; defines the end of the event
before or after the button click.  

These are the essential event button properties. Other properties are described in the Properties
list topic.

Other event creation tools

The team  group box tool and the Zone tool can be used to create events by setting their Action
property = event.  However, their default action is as keyword addition tools.

7.3.6 Keyword addition tools

Keyword addition tools are used to add keywords to an event. They do not create events.
Keyword addition tools can be one of two types:

Keyword tools - are used after an event has been created to add a keyword to that event
only

Persistent keyword tools - are activated before an event and add their keyword as the event
is created.  They remain active until deactivated and so can be used to add their keyword to
many events.

Keyword button

A Keyword button assigns an addition keyword value to the last tagged event (or to the selected
event in the Events List).

 

 

Persistent keyword button
The ppersistent keyword button applies its value to all events which are tagged while it is active
("pressed").
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For example, in tennis the name of the server could be assigned to a persistent value button.  All
events created while that button is active will be tagged with the server's name.

Persistent values can be very useful when the analysis consists of more than one
video file.  For example to allow you to differentiate between an event which takes place
one minute into the "first half" and another which takes place one minute into the
"second half".  First and second half are the persistent value buttons in this example.

Text box

The text box tool is a persistent keyword tool that assigns a variable keyword based on text
typed into the box. For example you might use this to include the name and date of the
competition or information about the conditions, as illustrated below:

 

Score panel

The score panel is a persistent keyword tool that lets you record the current score of the game.
 

Zone tool

The zone tool is used to record where an event takes place based on where an image is clicked. 
The recorded keyword is the coordinates of the clicked position.  The zone tool is further
described in the Zone tool topic

Important keyword addition tool properties

Property Description

Label / keyword properties These properties define the keyword to be recorded in the events
list. Where the keyword property is not set, the label on the button
will be used as the keyword.  By setting these properties to different
values, it is possible to tag a different keyword to the text displayed
on the button.

In the case of the textbox tool, the keyword property can be used to
define a default text box entry.

Category property Defines the column of the events list where the keyword will be
added. Without a category property the tool won't record its
keyword.

These are the essential properties. Other properties are described in the Properties list topic.

Other keyword addition tools

The Team Manager, Team Group Box and Player List Selector can also be used to add keywords
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to events.  Their use is described in the  topicsTeam Manager tool and Team Group Box and
Player List Selector

7.3.7 The Zone Tool

The zone tool is used to record where an event takes place based on where an image is clicked. 
The keyword it adds is the coordinates of the clicked position on a grid.

Using the zone tool

1. Set the image property:  Any image can be used but it is not resized by Dartfish, so it should
be created and edited at appropriate dimensions with image editing software before addition
to the panel.

2. Define the grid: F ield height and f ield width properties are used to define a grid e.g. a field
width value of 3 would split a soccer pitch  into three vertical sections or a field width = 100
would split an American football field into 1 yard sections.

3. Define the center of the grid: Field center X and field center Y properties are used to define the
center square of the grid. When the zone tool is clicked, zones to the left or above the central
zone record a negative coordinate, zones below and to the right record a positive coordinate.

4. Set the category: as with all tagging tools, the zone tool requires a category in order to be
able to record its keyword in the events list.

The image below shows the coordinates which are recorded when a zone tool with field height
and width=3 and Field center X and Y=2:

Each zone has equal dimensions. For sports with playing areas where the zones are not equal it
will be necessary to create a zone tool image which distorts the zones to equal sizes.

The grid is invisible.  If it is required, it should be defined on the image itself using image editing
software.

Event creation tool or keyword addition tool?

By default, the zone tool is a keyword addition tool.  It can alternatively be used to create
events.  To do this set the action property to event and define preroll and duration properties as
for an event button.
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7.3.8 Team Manager tool

If you have many players or several different teams to tag, you can use the Team  M anager to
store all teams and player names but then select only those players taking part in the game.  The
selected players can be represented on the panel by:

A Team  Group Box tool - can be linked to the Team Manager and displays buttons
representing each selected player.

A Player List Selector  - can be used to select a single team and player from those stored in
the Team Manager's database

See the topic Team Group Box and Player List Selector to learn how to link these tools to a team
manager.

The Team Manager tool

Very little needs to be done with the team manager during tagging panel creation.  Simply add it
to your panel; teams and players will be added after closing the editor.

Setting the category property for the team manger is optional.  If it is set then a keyword
representing the selected team will be recorded when a player button is clicked.
 

Team Manager databases

The teams and players that you add to a Team  M anager tool are stored in a database file which
is created automatically in the same folder as the tagging panel. However, you may want to use
a database previously created by you or another Dartfish user. 

Use the Database Editor tab of the tagging panel editor to select the database file that you wish
to use.

Each tagging panel can have only one database but have many team managers enabling
selection from different teams and players.

Adding teams and players

Teams and players are added outside the editor as described in the topic Using the Team
Manager

Important Team manager properties

Property Description

Label Using a label helps to identify a team manger.  This is useful when
linking it to a team  group box or when more than one team manger
is being used.

Category property The category property is not an essential property for a team
manager.  If used then a keyword representing the selected team will
be added to the events list.

These are the main properties to consider. Other properties are described in the Properties list
topic.
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7.3.9 Team Group Box and Player List Selector

Team Group box

A team  group box is a group box to which buttons are added by selecting players from a linked
Team  M anager as illustrated below.

  To simplify the layout of a tagging panel it is usually best to put a team manager on
a separate page of your tagging panel from the team group box and other tagging
buttons. During tagging most activities will not require frequent access to the team
manager; perhaps only before the start of the game.

Team group box buttons can add keywords or create events

Team group box buttons are Keyword buttons by default. Set the Action property to define
whether the buttons function as keyword buttons, persistent keyword buttons, event buttons or
continuous event buttons.

For example, a persistent keyword button might be used to tag the 'Server' to all the events
created in a tennis game. Or player possession might require the creation of an event or
continuous event.

Player List Selector

This tool allows you to select a single player from a linked Team Manager's database of teams
and players.  The selections you make are persistent keywords: the keyword is added to all
events created after a selection is made.

A player list selector can add up to two keywords to the events list:

A keyword representing the player added to the category set for the player list selector.

A keyword representing the team added to the category set for the team manager.  

If the team manager has no category property set then only one keyword,representing the
player, is added by this tool.

The player list selector is at its most powerful when selected players are linked to the
keyword property of event and keyword buttons using macros. Find out how in the 
Using variable keywords topic.

Linking to a Team Manager

A Team  M anager tool must be linked to a Team  Group Box or a Player List selector tool which
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will display the buttons. To do this, proceed as follows:
 

1. Select the team group box or Player List Selector.

2. Double click the Team  M anager Link property to display the property editor window (as
shown below).

3. Select the Team Manager to be linked; it is identified by its label and Id.

4. Click the Add button.  The Team manager on the right is that linked to the team group box.
 

Important team group box properties

Property Description

Team manager link Establishes a link to a team manager and its database of teams and
players.

Category property Defines the column of the events list where the keyword will be
added. Without a category property the tool won't record its
keyword.

Action Defines the button type used in a team group box.  The default
setting is keyword button but buttons can also be event buttons,
continuous event buttons or persistent keyword buttons.

Duration/Preroll If buttons are event buttons, duration and preroll properties should
be set to define these features of the event.  See the topic Event
creation buttons to learn more about these button types.

Important player list selector properties

Property Description

Team manager link Establishes a link to a team manager and its database of teams and
players.

Category property Defines the column of the events list where the selected player will
be added as a keyword

Number of keywords Up to 5 players can be selected from one team

These are the essential properties. Other properties are described in the Properties list topic.
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7.3.10 The Filename Template tool

The F ilenam e tem plate tool enables tagging panel creators to control the file name used to save
recordings made when using live tagging. When the user clicks the button it sets the file name for
the next video recording.

To use a filename template:

1. Add a filename template tool to the tagging panel

2. Set the label property to indicate the function of the button

3. Set the F ile Nam e Tem plate property to the desired file name

The file name template property can be set to a variable value based on the selection
from a Player List Selector tool.  See the topic Using variable keywords to learn more.

7.3.11 PTZ move button

This button is used by those who are using network cameras with pan-tilt-zoom (ptz)
functionality. The PTZ move button is used to to select preset camera positions.

The PTZ preset name property of the button is used to identify the PTZ preset to be used as
shown in the image below. 

Important team PTZ move button properties

Property Description

Label Information for the user to identify the button

PTZ preset name Defines the camera preset which will be selected when the button is
clicked. The values entered must correspond with those created on
the camera

These are the essential properties. Other properties are described in the Properties list topic.

The trigger property can be used to activate other tools and vice versa e.g. when a
'corner' button is clicked on a soccer tagging panel it could trigger the 'goal mouth' PTZ
move button.

7.3.12 Properties list

By clicking on any item on the tagging panel workspace, its properties are displayed in the 
Properties pane. The properties of each tagging panel element are used to alter their appearance
and behavior. 

Most tools have 3 crucial properties which you should set:

1. Label – the text that identifies what this tool does.
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2. Keyword – the keyword that will be assigned to the event (same as label by default)
 

3. Category – the category to which the keyword will be assigned. Think of the category as
being the column heading of the Events List  in which keywords will appear. (see Planning a
tagging panel for help to plan the categories that you need).

Properties which alter appearance:

Property W hat it does Applies to

Label Sets the text that is displayed on the item All

Tooltip The tooltip is the explanatory text that appears
when the mouse cursor is pointed at a button. Use
this to explain the function of each button.

All event creation and
keyword addition tools

Im age An image can be displayed on a tool to help identify
the event or value that it represents.

As the Zone tool is based on clicking an image, this
property  is essential.

Buttons, group boxes,
zone tool

Orientation For a button this defines whether the image is
displayed above or to the side of the label.

For a group box this controls whether buttons are
laid out vertically or horizontally.

Buttons, group boxes

Style Sets the color of a button All Buttons

Label size Makes the text on the button bigger or smaller to
improve readability, reduce space or to make
buttons bigger for touch screen tagging

All tools with a label
property

Label style Makes the text on the button bold to improve
visual ergonomics or to make buttons bigger for
touch screen tagging

All tools with a label
property

Im age size There are two possibilities: the image is a  fixed
size limited by the size of the button or it is the size
of the original image

Images on buttons,
group boxes

Properties which affect behavior:

Category The category property defines the events list
column into which a tagging tool's keyword will be
placed. 

Each tool inherits its category property from the
group box in which it is placed. It is therefore an
efficient way to categorize buttons of the same
category by placing them in the same group box.
Override the inherited category by setting the
category property for individual tools.

All

Keyword Defines the keyword which will be used to describe
the event in the events list. For buttons, the
keyword will automatically set to the same value
as the label property, however it is possible to
record a different keyword if desired. For example,
the label might be an abbreviation of the keyword.

All event creation and
keyword addition tools

Preroll Defines the time before an event creation tool is
clicked that will be included in the event. Preroll
ensures that you don't miss the start of the action.

All event creation tools

Duration Duration is the duration of the event that will be
tagged when this button is clicked. This time

All fixed duration event
creation tools
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includes any preroll that has been set. If the event
is not of fixed duration then a continuous event
button should be used to manually mark the
beginning and end of an event.

O ffset Start Offset Start - the amount of video before or after 
a continuous event button being clicked on that will
be included in the event. This ensures that you
don't miss the start of the action. If a negative
number is used, the start of the event is set before
the tool is triggered, if positive it will be afterwards

Continuous Event
Buttons

Offset End Offset End – the amount of video before or after a 
continuous event button being clicked off that will
be excluded at the end of an event. If a negative
number is used, the end of the event is set before
the tool is triggered, if positive it will be afterwards

Continuous Event
Buttons

Target Defines where the keyword typed into a text box
will be applied:

Event category - the keyword is added to the
events list

Video clip category - the keyword is added to video
clips captured with live tagging and appears in the
Dartfish library

Text box

Action Defines the button type of a team group box.

The default is for a team group box to contain
keyword buttons but this property can be used to
select any button type.

Team group box

Team
M anager Link

Used to link a Team Group Box to a Team Manager
tool. 

Team group box,
Player list selector

Num ber of
keywords

Used by the Player list selector to define how many
players can be selected

Player list selector

F ield width,
f ield height,
f ield center
X, f ield
center Y

Used by the zone tool to define the layout and
coordinate map of the zone grid.

See The Zone Tool

Zone tool

PTZ preset
nam e

Used by the PTZ Move button to identify the IP
camera preset to activate

PTZ move button

Properties used to automate tagging (see Automating tagging )

Shortcut Key Rather than clicking buttons on a tagging panel,
using the keyboard Shortcut Key property for
event or value buttons can be much more efficient.
Note that these shortcuts are displayed in
parentheses in each button

All event and value
tools

Reset
Category

Tools with a reset category property can be used
to deactivate other continuous event or persistent
value tools. When this tool is clicked, all other
buttons using the category specified are reset.

All buttons

T rigger The trigger property is a list of one or more tools
that can be activated when this button is clicked.

All buttons

Visibility This property is used to hide a group box and all its
contents.

Used when the action of the hidden tools will be

Group boxes
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defined by the tagging panel creator and shouldn't
be modified by the user or when it will be triggered
by other buttons.

Clicking on a property title in the properties panel displays a description of that
property. Double clicking on the property title allows you to change that property.

7.3.13 Automating tagging

Large tagging panels with many buttons present two problems to the user:

1. Many mouse clicks might be required to record an event, making it hard to keep up with a
fast moving game

2. It becomes more difficult to locate the buttons you want to use.

This topic explains properties and features which assist with these problems

Reset Category property

Tools with a reset category property can be used to deactivate other continuous event or
persistent keyword buttons. When the tool is clicked, all other buttons with the specified
category are reset. 

This behavior is equivalent to that of continuous event buttons (see the topic Event creation
buttons) which automatically deactivate all other continuous event buttons sharing the same
category, except that the reset category property will deactivate buttons from any other
category that you specify.

Be careful with spelling and use of spaces - the reset category you specify must match the
category of the tools that you wish to reset. However the case used is unimportant.

T rigger property

The trigger property is used to activate or deactivate other tools. This property specifically
identifies which tools will be triggered by selecting them from a list selected from a list.

Examples of the use of the trigger property can be seen in some of Dartfish's built-in tagging
panels where clicking an event button triggers a page of a tab group box revealing keyword
buttons associated with that event.

For example, when a scoring event is tagged the trigger property could be used to activate the
tab group box which contains a score tool.

To set a trigger property:

1. Select the tool which will trigger other tools.

2. In the properties panel, double-click the property heading T rigger

3. In the trigger dialog (see below) select the tool which will be triggered. Tools are identified by
both their label and Id; be careful to select the correct tool in the case where more than one
tool has the same label

4. Click the Add button

5. Repeat as often as required to create a list of tools which will be triggered

6. Use the Up and Down buttons to specify the order in which tools will be triggered
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Shortcut key property

Shortcut keys are used to trigger buttons without having to use a mouse. This can be useful
because once you know which keys to press tagging can be much quicker.

To set a shortcut key:

1 . In the properties panel, double-click the property heading Shortcut key

2 . Type a shortcut key

3. Click the Assign button. This must be done before clicking OK

As you can see here; more than one shortcut key can be assigned; and any combination of
keys can be used e.g. 'S' might be used for a home team shot and 'ctrl+S' might be used for an
opposition shot.

7.3.14 Using variable keywords

A simple macro can be used to generate a variable keyword or category for a tagging tool.

Syntax

$(Item_Id.property[#])

Example: $(teamlistselector.keyword1)
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I tem _Id is a unique identification which can be found in the first row of the properties list of
any tool. Here, it can only refer to a Player List selector

Property can be either "keyword" or "category". When keyword is used, the player selected
from the Player list selector is the variable keyword generated. When category is used, the
team is the variable keyword generated

# is a number from 1 to 5 which represents which of up to 5 keywords it is possible to select
from a Player List selector. This is optional, if omitted it is assumed to be 1 and refer to the
first keyword.

Text and macros can be combined together to create the desired result, as shown in the
examples below

Limitations

Only keyword and category properties can be set with a macro.  The exception to this is the
Filenam e Tem plate Button which can also have its F ilenam e tem plate property set.

Only a Player List Selector can be the source and only its category or keyword can be
referenced.

Example 1 - Personalized event buttons

In the following example, a macro is used to personalize the keyword property of the event
buttons:

The macro used to record these keywords in the above events list is, for example: 

Keyword = Winner $(TeamListSelector0.Keyword)

Result = Winner Pascal Binggeli

Example 2 - Filename Template tool

Continuing the example above, if a f ilenam e tem plate tool (see the topic The Filename Template
tool) has the following macro for its F ilenam e tem plate property:

keyword = Semi-final $(TeamListSelector1.Keyword) versus $(TeamListSelector0.Keyword)

result = New files created by live tagging would be named 'Semi-final Serge Ayer versus Pascal
Bingelli'

7.3.15 Saving Tagging Panels

To save your tagging panel:

Select F ile>Save (or F ile>Save As...) from the menu bar of the Tagging Editor panel.
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It can be seen from this process that tagging panels are saved as files, stored independently of
Dartfish software and the video file(s) being tagged.  Therefore the important factor in choosing
a file name and location for a tagging panel is simply that the user knows where to locate it.

Because a panel is saved as a file it can be easily distributed to other tagging users, however the
following items should also be distributed if they have been used in a panel:

1. The tagging database - if a team manager tool has been used a database file will have been
created with the same name and in the same location as your tagging panel.  It will have the
following icon:

2. Image files - any images included on your tagging panel are referenced as external files

7.4 Tagging video

In essence, the basic tagging process is simple; you see an event, you click an event button then
you click keyword buttons to add further details. The features that you might find on a tagging
panel are described in this section (see Using tagging panels)

Tagging can be applied in the following ways:
 

1. Tag Live - use this mode if you want to tag the action directly from a video stream, either as
it happens or from a tape recording (play back mode). In either case you will be tagging and
capturing video to your hard drive simultaneously.

 

2. Tag Video Clip - use this method if the video clip is already on your computer. In this case,
your task is to playback the video clip, locate an event and tag.

 

3. M ixed tagging - you do not always have time to fully and accurately define events as they
happen, or you may miss events. In this case, you are able to combine Tag live and Tag
Video Clip by playing back the video clip and editing/adding events after the game.

 

The result is a list of Events (displayed in the Events List, see The Events List) which can be
played individually or in sequence.

Events can also be "automatically" created by importing them from "character separated
value" (csv) files created by other applications, e.g. sport specific statistical tools or the Dartfish
Easytag App for iPhone and iPad (see Importing events ). 

7.4.1 Using tagging panels

Opening panels

Access to tagging panels is described in the topic The Tagging Panel. 

Tagging tool and feature summary

Below is a summary of tagging tools that may be found on a tagging panel.  However, Dartfish
tagging panels are highly variable and versatile, if the use of the tagging panel you use is not
obvious it may be necessary to ask for instruction from its creator.

Event button - clicked once to create an event with a fixed duration. Default color red.
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Continuous event button - appearance identical to event buttons but when clicked, it remains
activated until clicked a second time. Used to tag events of unknown duration such as
possession or phases of play.

Keyword button - keyword buttons add addition keyword to events. They are not used to create
events. Default color blue.

Persistent keyword button - appearance identical to keyword buttons but when clicked, it remains
activated until clicked a second time. Used to add a keyword to many events. Must be activated
before events are created and remains active until clicked a second time.

Text box - a persistent keyword tool which adds of a variable keyword to events as they are
created.

Score panels - a persistent keyword tool which adds the current score to events as they are
created.

Team  m anager - Displays a variable set of tagging buttons in a Team Group Box according to
which team and players are selected.  Has buttons to enable addition of teams and players.

Player List Selector - adds a persistent keyword based on the player selected.

Tab group box - used to simplify the layout of a panel by grouping related buttons together. Click
the tab to see the buttons; often selection of a tab is automated by the action of another
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button.

Zone tool - records the coordinates of where the image is clicked. Can be either used for event
creation or keyword addition.

File name template tool - used to set the filename of recordings made during live tagging.

7.4.2 Tag Video Clip mode

Use this mode to tag video file already existing in the library - it has been imported from the
camcorder or other storage media. Tag video clip mode is selected by clicking the button at the
top left of the video display. 

Tagging a video clip principally consists of these steps:

1. Loading all the video clips to be tagged into the T ray (see the topic The Library in the Tagging
workspace section)

2. Selecting Tag Video Clip mode

3. Finding the relevant position on the video clip (see below).

4. Tagging an event in the video clip by clicking on an event button on the tagging panel.

5. Adding further keywords to that event by clicking on keyword buttons.

Finding the relevant position

Compared with Live tagging where events must be created in real time and in order, tagging a
video clip allows the user greater flexibility.  There are many ways to quickly navigate the video
clip find the positions where events take place:
 

Drag the playhead to quickly position the video clip. Watch the time information next to the

playhead as you drag it. It can help you position the video if you approximately know when
an event took place.
 

 
 

Use the speed control to fast-forward and/or fast-rewind the video. To do this, set the speed

to values greater than 1 (or -1 for fast-rewind) and play the video. Whenever you see an
event, either click on an event button or pause the video first, and then select the appropriate
buttons to tag the event.
 

 

 

Position the playhead to a previously tagged event and continue tagging from there. The way
to do this depends on the tagging mode being used:
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In Tag Video Clip mode, click the event once to move the playhead to the start of that event
In Play Events mode, double click the event then switch back to Tag Video Clip mode to
continue tagging. The playhead remains at the position of the selected tagged event.

When the action is too fast to tag as the video plays, the video can be quickly paused
by tapping the space bar on the keyboard.  Now add tags before tapping the space bar a
second time to resume playback.

7.4.3 Tag Live mode

Tag live mode allows you to tag while recording video from a live video stream. This allows
tagging to take place during the game and be ready for analysis immediately afterward. Tag live
mode is selected by clicking the button at the top left of the video display (see The Video Panel). 

The Tag live interface

The interface is identical to the Video Recorder interface:  Read the section Video Recorder:
capture a video stream in the Video Im port chapter to learn how to use it.

Tag live process:
 

1.  Click the Record button. The video clip starts being captured to your hard disk. The live
feed is displayed in the Video Panel. Use the tagging panel buttons to tag events as they
happen. In tag live mode it is not possible to tag without firs starting to record.

2. Tag an event by clicking an event button on the tagging panel.

3. Add further keywords to that event by clicking on keyword buttons.

4.    Click Pause Recording (optional). You may wish to use this during parts of the
competition of no interest to you; half time, injury stoppage, gaps between competitors etc. 
Pause recording is only possible when using DV video streams 

5.  Click Resume Recording (optional), to continue recording. Note that the pause/resume
recording does not create a new video clip.

6.  Click Stop Recording at the end of the game. A new clip is saved on your hard drive and
a thumbnail appears in the Tray.

It takes practice before you are able to accurately tag all events as they happen.
Start simply by tagging "important" events without adding too many additional values.
Read the section Review & edit events to see how you can edit and/or add events after
they have taken place.

If tagging from the replay of a tape, a set of controls allowing control of the video camera
appear on the video display.

Time shifted recording

When tagging live it is possible to use time shifted recording when the video source provides a
DV, HDV, M2TS, MP4 or H.264 video stream. Time shifted recording allows you to review earlier
parts of the recording while continuing to record. This can be done by:

Clicking the time line to move the playhead to that point of the recording

Selecting an event from the events list

To return to the 'live' view of the video feed from the camera, click the Live button
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7.4.4 Using the Team Manager

Adding teams and players
 

Adding players and teams to the Team  M anager is not completed in the tagging panel Editor but
after the tagging panel has been created and saved. Buttons at the bottom of the Team  M anager
allow you to (left to right) add/remove teams and players from the team manager. 

You may want to create more than one team if you tag several teams or squads but at least
one team must be created before adding players. After adding teams and players, their

properties (such as team/player name) may be altered by clicking the  button next to the
item to be edited.

 

Selecting players
 

Players are selected/deselected by 'ticking' the box next to their name. If the box is ticked, a
button representing the player will appear in the team group box linked to this player manager
control.

  

Philippe has been ticked, so…

… a button representing him appears in the team group box  

7.4.5 Using keyboard shortcuts

Using the keyboard to activate tagging tools can be much more efficient than using the mouse.
Buttons which have a keyboard shortcut display it below the label; it is used simply by pressing
the keys indicated.

Keyboard shortcuts only work when the tagging panel is active.  Look for a green line at the
top of the panel and if the line is red, click anywhere on the panel to activate it.

Score panels can also have keyboard shortcuts but they are not displayed - the tagging panel's
creator can advise you.
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7.4.6 Manual tagging

Manual tagging divides a video clip into a series of sequential segm ents where  adding a new
segment defines the end of the previous one.  Each segment is described by a label, description
and keywords which are manually entered as required.

Events can be added to segments . Their duration is defined by the point at which they are added
until the end of the segment.  They inherit all of their segment's keywords as well as being further
described by their own keywords. 

Typical uses

1. Manual tagging is a simplified form of tagging where it is not necessary to create a tagging
panel and keywords can simply be added as required.

2. Segments are useful for dividing a video into sections. Their label, description and keywords
are especially useful when they are exported as video clips or the tagged video is uploaded to
dartfish.tv.

3. Segments can also be considered as a way of tagging events in the same way that a text box
adds a persistent keyword to events on a button-based tagging panel.

To understand its intended use it may help to know its origins, it was created for The City of
Lausanne to distribute video of council meetings on dartfish.tv. The segments are of each session
and events are used to identify minuted details.  Their dartfish.tv channel uses the keywords and
descriptions applied by manual tagging to enable citizens to search for discussions. However,
Manual Tagging has applications as a tagging tool for many other situations.

Creating Segments

1. Click the tagging panel's Select button and choose M anual T agging from the menu

2. Click the  New Segm ent tab of the tagging panel

3. Enter a label and a description.  This information is used to describe the Segment when
published to dartfish.tv

4. Segments are defined by adding categories and keywords to the table.  One segment can be
defined by many keywords.

5. When the segment is fully described, click the Add button to create an event in the Events list.

6. Repeat  steps 3-5 to add further segments.  Each one added alters the previous segment's
duration so that each segment ends as the next begins.

Creating Events

1. Click the  New Event tab of the manual tagging panel

2. Enter a label and a description.  This information is used to describe the event when published
to dartfish.tv

3. Events are defined by adding categories and keywords.

4. When the Event is fully described, click the Add button to create it in the Events list.

5. When a new segment is added, the durations of all the events from the previous segment are
set.

7.5 Importing events

You can create events by importing them from a .csv (character separated value) file provided
that the data contains a column of time-stamps representing the position of each event. This will
be useful to the following groups:

Those using the Dartfish EasyTag App for Apple and Android mobile devices.  EasyTag allows
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you to create events using a tagging panel similar to a Dartfish panel, and then export the
results as a .csv file.
Easytag import is simpler than described below because steps 4,5,6 and 7 are unneccessry

Those that already use data logging software which creates statistics but does not relate the
event to video or allow visual analysis.  If this software can create a CSV file then the results
can be imported into Dartfish.

It is also possible to use data exported from certain other tagging software. At time of writing
these include products from Opta and Sportstec and in each case the exported data is either not
in a .csv format or the layout or data is not optimal for use with Dartfish. To use this data a
product specific add-in must be installed as described in the topic Importing events using add-ins

To import events

1. Pause the video or set the cue in to an easily distinguishable moment in the video. Doing so
will simplify the synchronization of data and video.  This can be one of the following
possibilities:

The moment representing zero time on your imported data.  For example, if you started
your EasyTag timer at the start of the game, pause the video or set the cue in at that
point.

An easily identifiable tagged event

If the event timestamp was added using a preroll, position the playhead at the start of
the event rather than when the button was clicked

 

2. Select Im port Events... from the Im port/Export button located in the Events list toolbar.
 

 

 

3. Locate and open the .csv file. The Import Events wizard then opens.
 
 

4. Choose the delimiters which separate each column of data in the imported file. If unsure,
experiment with the various choices remembering that more than one delimiter might be
used. The data preview will reveal when your data is successfully separated into columns.

5. Select which column heading in your data corresponds to the default category Position.
Optionally, columns representing the duration and nam e categories can also be selected if the
data contains them.

6. Select the time format used in the imported data. 
The preview shows the original data in brackets next to the time interpreted by Dartfish
according to the selected time format:  If the format is not correct, the times shown in the
position and duration columns will all be "0" or appear very obviously wrong.

EasyTag time format is hh:mm:ss.ms and is automatically selected 
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7. Decide which categories and events to import by ticking or unticking the headings at the top
of each column and side of each event.

 

 

8. Select how the imported data is to be synchronized with video.  The method depends on the
choices made in step 1 and are described in the topic Synchronizing imported events.

7.5.1 Importing events using add-ins

Although Dartfish can import .csv data into its events list (see Importing events) the data
exported from some sources is not always optimal for use  with Dartfish. For certain products,
add-ins are available which process the data during import. At time of writing these include
products from Opta and Sportstec.

Installing add-ins

1. From the menus, select Tools >Options

2 . Select Add-ins from the list on the left
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3. Select the Get Add-ins option

4. Choose an add-in from the list of those available

Dartfish may add or remove add-ins. The list shown above is only representative 

5 . Click the Install button

Importing events using an add-in

First you will export a data file from the third party software. Refer to its documentation to
discover how to do this. Some software may offer multiple outputs, in this case, refer to the
Dartfish Options to discover which file type is supported.

Now use Dartfish as follows:

1. Pause the video or set the cue in to an easily distinguishable moment in the video. Doing so
will simplify the synchronization of data and video.  This can be one of the following
possibilities:

The moment representing zero time on your imported data. 

An easily identifiable tagged event

If the event timestamp was added using a preroll, position the playhead at the start of
the event rather than when the button was clicked

 

2. Select Im port Events... > from the Im port/Export button located in the Events list toolbar.
 

 

 

3. Locate and open the data file exported from . The Import Events wizard then opens.
 
 

4. The correct delimeters, default data and time format will be automatically selected, but yuo9
may wish to choose which categories and events to import by ticking or unticking the
headings at the top of each column and side of each event.

 

 

5. Select how the imported data is to be synchronized with video.  The method depends on the
choices made in step 1 and are described in the topic Synchronizing imported events.
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7.5.2 Synchronizing imported events

Unless video recording was started at time 00:00:00 of the imported data, it will be necessary
to synchronize data with the video.

This is done by matching a time in the imported data to a position in the video denoted by one of
the following: the start of the video clip, the Playhead position or the Cue-in m arker position.
Consider the following common examples:

Synchronizing using the data's zero time

The simplest case to synchronize is when the timer of Easytag or your data logging software is
started at an easily identifiable moment that will appear in the video.  For example, the kick-off in
a soccer game (as illustrated below). 

If you need to start the timer before kick-off or where there is no easily identifiable moment
before the first tag, you can raise a hand in front of the camcorder as the timer is started.

To synchronize data in this case:

1. Before import set the Playhead (or Cue-in marker) to the video position where the timer
started.

2. During import leave the data position at 0 sec and select which video position that
corresponds to.

Synchronizing using an event position 

In the case that time zero for the imported data is unknown or otherwise not possible to identify
on the video, you can synchronize the position of an event with a video position as illustrated
here:
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To synchronize data in this case:

1. Before import set the Playhead to the start of the event that you will use for synchronization.

2. During import find the same event in the data preview and double-click it to select it

3. The data synchronisation position is set to the time of the selected event

Synchronizing events after import

Synchronizing events, or adjusting synchronization, after import can offer more versatility than
synchronizing during import.  For example, it is possible to give a different offset to different
types of event.

How to adjust position and duration of events is described in the topic Editing event timings

Synchronizing modifies the time stamp for all events.  It is therefore important that the time
coding on your data remains comparable  throughout the video clip.  This means that if you
pause the Easytag or data logger timer during time-outs you also have to simultaneously pause
video recording or vice versa.  If you record the game as multiple video files you will have to
import the events of each file as separate imports.  For convenience it is best to record both
video and the timing of events continuously and for as long as reasonably possible during the
game.

7.5.3 Quick Import

Quick Im port is a tool allowing you to quickly repeat an import using exactly the same settings
as previous imports.

To use Quick Import, proceed as follows:

1. Set the Playhead or Cue-in marker to an offset position.  Remember that the same offset
settings will be used as previous imports.

2. Select Quick Import... from the Import/Export menu located in the Events list toolbar.

 

3. Locate and open the .csv file.

4. The data is imported.

If Quick Import is used when no previous imports have been made then the full Im port Events
options will be displayed (see the topic Importing events).
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7.6 Review & edit events

Play Events mode is used to review and edit tagged events. To use play events mode you click
the Play Events button on the m ode bar above the video display.

 

 If it is not already displayed you also need to open the Events List by clicking the Events List

button  on the views bar above the video display .

7.6.1 Selecting events from the Events List

Selecting and playing events
 

Single click selects the clip - use the playback controls to play it.
 

Double click selects and plays the clip.

 

Sorting events
 

Events may be sorted by clicking any of the category headings.

 

List Overlapping
 

 

Remember that events can overlap. For example, in soccer a shot at goal event will overlap with
a goalkeeping event. This button displays events that overlap with the currently selected event.

 

Selecting multiple events
 

By selecting more than one event you can indicate which events in your events list you want to
play, edit or delete. Selecting several events is possible by the following methods:
 

1. Select several isolated events – hold down the control [ctrl] key on the keyboard and click
each event in turn.

 

2. Select a group of sequential events – click the first event in the group then hold down the
shift key and select the last event in the group.

 

3. Select all events – click any event and then use the keyboard shortcut ctrl + A

7.6.2 Editing the event

Editing keywords
 

An event's keyword information can be added to or changed in 2 ways:
 

Method 1: Use the tagging panel – when an event is selected in the events list, its keywords may
be changed using the tagging panel's keyword addition tools.
 

Method 2: Click the right mouse button while pointing at the keyword to be changed and
choosing Edit from the quick menu. A new keyword may be typed or selected from a list. 
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Selections of multiple events can be edited simultaneously using either of these
methods

 

7.6.3 Editing event timings

To edit position and duration using the time line

The following method allows you to make modifications by selecting a start and finish point for
the event in reference to the video.
 

1. Activate the M axim ize play range function in the Timeline to zoom in on the event.
 

 

2. Click on an event in the Events list. The event corresponds to the play range; the pale blue
area between the Cue In and Cue Out point. 

 

 

Drag the Cue In and Cue Out points to modify the event's position and duration.

M axim ize Play Range view immediately readjusts making it appear that nothing has changed
but note the new position or duration displayed in the Events list.

To edit position and duration using the events list

1. Select the events to be modified.

2. Click the right mouse button while pointing at the duration of one of the selected events and
choosing Edit from the quick menu. 

3. Edit the existing time or type a new one.

4. Press the enter key to confirm the change

It is not necessary to enter a new duration in the full time format displayed. Simply
entering the value '10' would set the duration to 10 seconds.

To adjust timings using the events list

The video position of a single event can be modified as described above but when timing of
position or duration require adjustment it is possible to add or subtract time in the following way:

1. Select and edit events as described previously

2. Key a + or - in front of the new value depending on whether time is to be added or
subtracted

For example, entering +5 would add 5 seconds to the selected times; entering -1:30 would
remove 1 minute 30 seconds; and entering +1:25:00 would add one hour and twenty-five
minutes. 

If unsure about how to apply the correct time format, simply edit the existing value



139Tagging Video

© Dartfish. All rights reserved.- Version 7 -

and place a + or - in front.

7.6.4 Hiding unused categories

The Events List continues to display categories used by previous tagging projects even if they are
not used by the current tagging session. The categories may be removed from the events list
by:
 

1. Right clicking any column heading, and
 

2. Choosing Reset colum ns from the quick menu that appears.

7.6.5 Reviewing events and video during live tagging

When using Tag Live mode it is possible to replay video while continuing to record. This will allow
you to:

Tag events that were missed and edit incorrectly tagged events

Review the action to make informed coaching decisions during the game

To review video

1.Click and drag the Playhead to the position on the time line you wish to review.

2.The recorded video plays from this point but the video display controls can be used to control
playback frame-by-frame etc

To review an event

1. Click the event in the Events List to select it

2. The Playhead jumps to the start position of the event on the Timeline

It is not possible to enter Play Events m ode while continuing to record

Returning to viewing live

The Live tagging video display controls has a Live button which returns the playhead to the end of
the timeline i.e. the live view
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7.7 Filtering and viewing statistics

Tagging will typically result in a long list of events. Locating particular events or analyzing their
frequency using the events list alone would be a difficult task. There are three methods for
searching for events:

Table filter

The table filter cross-references two keyword categories resulting in a matrix of frequencies.  This
can be used both to filter and to generate statistics. The table search is described in the following
topic.

Simple filter

The events list toolbar has a simple filtering tool which displays events based on an inputted
value.

The results of the simple filter can be further refined using the Keyword f ilter.

Keyword filter

The search pane is located on the left side of the Events list and gives access to both the
keyword search and the table search.  To execute a keyword filter

1. Select the Keyword tab of the search pane

2. Click a keyword to select it.  The events list immediately displays events matching the
selection. 

3. Select additional keywords by holding down the ctrl key as keywords are clicked.

When keywords within the same category are selected they behave as an AND search but when
selected from different categories an OR search is the result.  The following example would show
shots off goal and on goal by player Lemma.

Combined filter

The results of the simple filter and the keyword filter combine.  

For example, the keyword search above could also be carried out in the following way:
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7.7.1 The table search

The search pane is located on the left side of the Events list and gives access to both the
keyword search and the table search.  To create a table search:

1. Select the Table tab of the search pane

2. From the drop down lists at the top of the pane, choose the categories to cross reference.

3. A frequency matrix is created as shown below.

 

Filtering using a table search

Clicking each figure and heading of the resulting table filters the events list to match your
selection

7.7.2 Undo searches

Searches reduce the event list to displaying only search results. To see all events, click the show
all button above the events list.

 

 

7.8 Producing & sharing tagging resources

Having tagged a video you may want to share that work with others.  It is easily possible to
share:
 

Game video complete with tags



142 Dartfish User Guide

© Dartfish. All rights reserved. - Version 7 -

 

Individual events - as separate video clips or as a compiled highlights video.
 

The events list - can be exported as a .CSV file
 

The tagging panel - tagging panels are saved as files.  To give others access to your tagging

panel, simply give them the file.  They use the Create Events pane to open the tagging panel.

Dartfish offers the possibility to publish to a range of outputs including CD/data DVD and online to
your own FTP site or to Dartfish TV; our own media sharing platform (see www.dartfish.tv).  To
get a more comprehensive view of publishing from Dartfish see the Dartfish outputs - publishing
& sharing chapter.

7.8.1 Sharing game video

There are two possibilities depending on whether you want to share tagged or untagged video
 

1. Share Video Clips from the T ray the .dartclip file for each clip.  The dartclip contains events list
data so this is the best method to share video with other Dartfish users.  Of course you can
also Share match video with non-Dartfish users but if you want them to see tagged events it
would be better to use the method below. Learn more about sharing video clips from the 
T ray and all the possible output destinations in the Publishing and Sharing chapter. 

 

When dartfish.tv is chosen as a sharing destination, video but not events are shared.

 

2. Publish from the Events List - send video and events to Dartfish TV where it can be viewed by
all who have access to your channel.

 

 

To publish game video to Dartfish TV
 

1. Load game video(s) into the T ray.
 

2. Filter for and/or select the events to be published with the game video (optional).
 

3. Click the Publish button on the Events List toolbar.
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4. Select Publish gam e...  The Publishing Wizard opens.
 

5. Publishing Wizard step 1 - select dartfish.tv as the publishing destination.
 

6. Publishing Wizard step 2 - login to dartfish.tv and select the channel and collection.
Collections are defined by your channel administrator and cannot be created or modified from

Dartfish software.
 

7. Publishing Wizard step 3 - video selection
Choose which of the T ray's contents are to be shared.

 

8. Publishing Wizard step 4 - select which events are to be displayed with the published video.
Filtering or selecting in step 2 may make this easier.

 

9. Publishing Wizard step 5 - content categorization
 

Some categorization will be done based on the keywords assigned to video (see Organizing

your Library in the Library chapter).  In this step you can add further keywords to help others
find videos that you publish.  Some information is mandatory as defined by the channel
administrator.

 

 

10.Publishing Wizard step 5 - define publishing options:
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Here you can define:
 

What is viewed on the Dartfish TV platform - rather than the full video a shorter trailer can
be played to help viewers decide what to download.

What quality of video is available for download - it is possible to define a higher quality for
offline viewing. 

Attachments - the tagging panel, a statistics analysis spreadsheet or any file can be
attached and downloaded with the video.

To use tagged video downloads from dartfish.tv (dartfish users)

Dartfish users can use tagged video from Dartfish.tv.  To do this:

1. Download the video clip from dartfish.tv from the downloads section of the video document 

2. Download the .dartclip data file from the attachments section to the same folder as the video.
 

3. When the video is opened in Dartfish tagging, the events will appear in the events list

 

To use tagged video downloads from dartfish.tv (non-dartfish users)

Non-dartfish users can download tagged video but should use the download to Dartfish Player
option to be able to view events off-line.

7.8.2 Publishing events

Events can be shared independently of the entire game video in 3 ways:
 

1. Publish them as individual video clips - a selection of events can be directly burned to CD or
published as new video clips. Then you might insert the newly created video clips into video
editing software to create motivation video with transition effects and music. Or they can be
loaded in the T ray, saved as a Playlist and are ready to be presented to your team. The
presenter only needs to know the basic playback functions of the Player. 

 

2. Publish a highlights movie to Dartfish TV - a compilation movie of selected events which can
be viewed by all who have access to your channel.
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3. Export them to the Analyzer Storyboard - here they can be annotated and published using
the powerful tools of the Analyzer.  This is explained in detail in the topic Storyboard.

 

To Publish events as new files
 

1. Select events in the Events list and click the Publish Events button. Multiple selections can be
made by holding down the CTRL key while clicking each event.

 

2. Select Publish Events...   
 

Video clips can be published to three different destinations, as illustrated below:
 

 

1. M y Com puter - a new video clip of each selected event is created. Video quality can be left
unchanged (applies to .wmv, .avi and .mpeg video settings).

 

In the last step of the wizard, you have the option of generating a Playlist of the newly

created video clips. Select a destination directory, enter the name of the Playlist and click on
the Save button. A Playlist with the file extension *.playerproject is created. It contains links
to the new video clips. You can open this Playlist in the T ray and present it to your team using
the Player.

 

2. Recordable CD or DVD or Enhanced Recordable CD or DVD - selected clips are burned on a
CD. Read Sharing video files in the Video Library chapter to learn about these two
destinations.

 

To publish a highlights movie on Dartfish TV
 

1. Perform a search to Select events in the Events list and click the Publish Events button.
Multiple selections can be made by holding down the CTRL key while clicking each event.

 

2. Select Publish Highlights... to launch the Highlights Publishing W izard.
 

3. Wizard step 2 - Select which videos you wish to share. "Check" those to be shared as shown
below or click the Select All button:

 

 

4. Wizard Step 3 - provide additional information to aid those browsing your channel or
performing keyword searches for similar movies:
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Keywords are searchable terms that link movies of similar types on your channel.  The

tagged keywords for each event are used as keywords so it is only required to provide
additional keywords.

 

5. Wizard step 4 - Attach related documents and define offline viewing preferences.
 

 

Some channels allow download of video for viewing offline.  Set what quality of video is to be

used remembering that higher quality will take additional storage space and encoding time.
 

Attached documents can be any file you wish to be associated with the video.  They are

downloaded with video files.
 

This is the final step before processing and upload of files to Dartfish TV.
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7.8.3 Adding notes to events

Text notes can be added to events.  To do this, proceed as follows:

1. Click the event with the right mouse button

2. Select Properties from the quick menu

3. Edit the notes section of the general tab

Using event notes will be principally of interest to contributors to dartfish.tv where notes will be
easily viewable as event marker notes.

7.8.4 Storyboard

Storyboard - selected events can be "transferred" to the Analyzer module and analyzed as any
other Storyboard item .  In many ways the Analyzer's Storyboard is the best presentation and
publishing tool for the following reasons:

Analyzer zoom and drawing tools can be used to help illustrate and explain.
 

The Storyboard can be presented using the remote control in the same way as the events

list.  But with the advantage that a selection of many events from different searches can be
compiled in the storyboard.

 

The Analyzer offers additional outputs such as the Mediabook and Analysis Recorder.

 

To add events to the Storyboard:
 

1. Select events in the Events list and click the Storyboard button.
 

 .
 

2. Select the range of events to be exported.
 

 

Each selected event creates a new storyboard item.  The process of selection and adding events
can be repeated until the Storyboard contains all the events to be presented.  See  An analyzer
project - the Storyboard in the Analyze perform ance chapter to learn more. 

Remember that a storyboard's contents can be saved to allow recall at a later date.

7.8.5 Exporting events

To export events:
 

1. Select events in the Events list

2. Click the Export Events... option of the Im port/Export button
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3. Select the range of events to be exported.
 

 

Your selection is exported in a CSV file which can be opened in spreadsheets and databases to
analyze statistics and create graphs. You can also use such files as backup copy of your tagging
work.  Such a file can be imported later and re-synchronized to the video (see Importing events
).



Chapter

VIII

Displaying metadata from
external devices
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8 Displaying metadata from external devices
Dartfish's Analyzer and InTheAction modules support the display of data from other
software applications. For example, timing devices, heartrate monitors or power
measurement devices that use sensors linked to software can use Dartfish's
Metadata toolkit to send the processed data to Dartfish Software.  Such metadata
adds to the interpretation of video images by relating them to the effort of the
performer.
 

Throughout this tutorial, the term "metadata" will refer to data (in a broad sense)
generated by entities external to Dartfish Software and captured by Dartfish
Software while capturing a video clip. Examples of such metadata are heart rate,
speed, etc.
 

It is assumed here that you are already familiar with the use of InTheAction (see
xxx)  and the Analyzer (see xxx).

 

To display metadata on Dartfish video images need to:
 

Activate advanced options supporting metadata capture and display.
 

Use the InTheAction module to capture metadata streams while capturing
related video images.

 

Link drawings superimposed on video displays to metadata values.
 

Use the Analyzer module to replay previously captured video with related
metadata.

 

This tutorial covers how to do this and additionally how the Drawing Libraries can
be used to make the display of metadata.  You will also learn how to display
metadata values graphically next to video images.

8.1 Support for metadata in Dartfish Software

For data from external software and devices to be displayed in Dartfish it is
obviously not as straightforward as connecting the device

Metadata can be captured and displayed. These tasks are performed using 2
modules:
 

InTheAction module, for capturing video clips and metadata synchronously.
 

Analyzer module, for displaying metadata and performing some analysis.

Apart from these 2 modules, there is no support for metadata. For example, it is
not possible to display metadata with the Player.

In these 2 modules, the metadata features are enabled by advanced settings that
are available in the "Options" dialog (Advanced Options).
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8.2 Setting Advanced Options

To use (capture and display) metadata in Dartfish Software, 5 advanced options
can be enabled. These 5 options are devided into 3 groups:

Metadata group - Capturing, saving and displaying metadata (not in the video).
Metadata overlay group - Using overlays on the video to display metadata on
the video.
Overlay drawing repository - Enabling Drawing Library for defining several
video overlays that can be selected during video capture.

In Dartfish Software, these different options are accessed in the "Advanced" tab
under "Options" menu item in "Tools" menu ("Options" dialog can also be directly
accessed by depressing the "F3" key). These options are shared amongst the
"Analyzer" and the "InTheAction" modules.

The figure below depicts the different options as they are displayed in the
"Options" dialog (they have been highlighted in the picture):

8.2.1 Analyzer Advanced Options

Load embedded drawings - this option allows the analyzer to load the drawings
(if any) that have been saved with a video clip during its capture. If this option is
disabled, the Analyzer will only load the video (and possibly the metadata if the
"Display metadata viewer..." option is enabled). In order to save drawings with a
video clip, the advanced option "Save currently selected overlay drawing with the
video clip" must have been enabled in the InTheAction (ITA Advanced Options)
prior to saving the clip.
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Display metadata viewer for allowing metadata analysis – this option belongs
to "Metadata group" and must be enabled for the Analyzer module to display the
metadata graph under the videos.

8.2.2 InTheAction Advanced Options

Receive, record, and save metadata - this option enables the InTheAction
module to receive, record, and save metadata with the video clip.

Save currently selected overlay drawing with the video clip – when enabled,
the drawing that is currently displayed in Live or Replay mode is saved with the
video clip at the end of the capture when the user saves the video clip. The
drawing can later be automatically loaded and displayed in the Analyzer (if the
"Load embedded drawings" option is enabled).

Use Drawing Library – the Drawing Library stores up to nine different collections
of clip drawings (see specific section later in this document). When this option is
enabled, the library is used for managing the drawings in the InTheAction module. 
This option also d isp lays add itional tools on the InTheAction left toolbar.

8.2.3 Section summary

In this section you have learned which options you need to activate to be able to
display metadata.  You are now ready to capture metadata and video images
simultaneously using DartFish's InTheAction module.

8.3 Capturing & displaying Metadata with the InTheAction

The InTheAction module is used for recording Metadata (it is currently not possible
to use the DVImport module to record Metadata). The "Receive, record and save
metadata" advanced option must be enabled (Advanced Options).

When receiving external data, the InTheAction module automatically creates a data
source stream for each received data stream. These data source streams are
created automatically as the data is received. This has the following important
consequence: no data source stream s are availab le until Dartfish Software has
received som e data.

The current values of the metadata streams can be displayed in InTheAction's Live
mode (see Displaying Metadata in Live Mode). Even if the metadata is not
displayed on the video in Live mode, the metadata streams are nevertheless
recorded with the captured video clip but on ly if the advanced options for record ing
the m etadata have been enab led for the InTheAction module (ITA Advanced
Options).
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8.3.1 Checking that Metadata is received

The list of data source streams and their properties can be displayed in
InTheAction.

Select the "Manage metadata repository" menu item in the left ITA toolbar as
follows:

 

Note: if this menu is not displayed in the left toolbar, you have to enable it in the
advanced options (see InTheAction Advanced Options).

The following data source list dialog is displayed showing the different data
sources and their metadata streams.

The content of this dialog content is not automatically refreshed. When this dialog
is left opened and new metadata streams are detected by Dartfish Software, you
must depress "Refresh" button to update the dialog list view (or close the dialog
and reopen it). 

In this example, 2 data source streams have been received: "Heart Rate" and
"Spin Amount". The "Heart Rate" data stream has integer values (e.g. 123, 150).
The "Spin Amount" data stream has float values (e.g. 12.34, 0.34E-2).

All data source streams that are displayed in the DataSource List dialog are
recorded with the video clip. Currently, it is not possible to select which data
source stream will be recorded with the video.

If no data source streams are displayed this indicates that the Dartfish Software
has not received any data yet.

The list of received metadata streams is not saved when quitting Dartfish Software.
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8.3.2 Displaying Metadata in Live Mode

Metadata stream values in the InTheAction module are displayed with overlay
drawings that are drawn on the video image.

First check that data source streams have been detected (as explained in
Checking that Metadata are received in InTheAction).
Switch the InTheAction module to Live mode.
Select the Source drawing (usually this is the default setting):

Depending on the type of data contained by the data source stream, you must
select the appropriate drawing tool. For integer values, select the "Text" drawing
tool. For float values, select the "Text" or "Graph" drawing tools. For vectors with
origin (Vector6) data type, select the "Force Meter" drawing tool:

Note: if this menu is not displayed in the left toolbar, you have to enable it in the
advanced options (see Advanced Options).

Note: drawings can be resized on the screen using different handles that depend
on the type of drawing. "Force Meter" drawings also offer a yellow handle for
resizing the length of the displayed moving arrows. 

Draw on the video using one of the drawing shapes selected in the previous step.
Select the shape and right click on it to display a popup menu.
Select the menu item "Metadata Properties..." as below:
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If this menu item is grayed, no data source streams are available or no
compatible data source streams are available.

The following dialog is then displayed:

To assign a data source stream to the current drawing, click on "Linked to the
following Metadata source" option button and select the targeted data source
stream using the 3 list boxes. If the "Linked to the following metadata source"
option button is disabled (grayed) then it is not possible to assign a data source
stream to the drawing (there are no compatible data source streams currently
available).

The drawing shape displays the value of the linked metadata stream. For
example, a "Text" drawing displays a value and a graph drawing displays a
graph.
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8.3.3 Section summary

In this section you learned how to capture metadata with a video clip.  This
metadata can be displayed in the Live mode by linking drawings to the metadata
stream.

The next section will cover how to use the Analyser module to display metadata on
previously captured video and display metadata graphically.

8.4 Using Metadata in the Analyzer

The Analyzer module is used for observing and comparing stored video clips and
their recorded metadata. When a clip is opened in the Analyzer, any recorded
metadata can be displayed in a graphic view as below:

The tree view on the left side of the graphic view and its associated small tool bar
are described in the following chapters.

When multiple clips containing metadata are opened, the metadata corresponding
to each clip is displayed in the graphic view. Each graph is color-coded with the
corresponding color of each clip's timeline. For example, the yellow graph
corresponds to the yellow clip in the timeline.

The graph part of a video clip is synchronized with its timeline. For example, in the
graphic view above, shifting the yellow timeline to the left will also move the
yellow graph.

8.4.1 Displaying Metadata diagrams

Metadata stream values can be displayed in the Analyzer module as a graph
synchronized with the timeline:
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Proceed as follows to display metadata graphs in the Analyzer:

Enable the "Display metadata viewer for allowing metadata analysis" advanced
option (Analyzer Advanced Options).
Display the graph part by clicking on the graph button on the Analyzer left
toolbar (by default the graph part is hidden):

Note: if this button is not displayed in the Analyzer left toolbar, you must enable
some advanced options (Analyzer Advanced Options).

Open a video clip in the analyzer.  Any metadata previously captured with the
InTheAction module is displayed in the graph part of the analyzer under the
timeline.

The different buttons in the graph toolbar alter the way the graph is displayed.

The  button displays simple statistics such as min, max and average values.
The In and Out points act as delimiters for these calculations.

The  button displays the data value corresponding to the value at the cursor
position in the timeline on the top right corner of the graph. (e.g. –9.72 and –
2.00 in the picture above).

The  button displays the name of the currently displayed metadata stream in
the top left corner of the graph (e.g. "Channel 1" in the picture above).

The  button toggles between single or multiple clip display. When multiple
clips are simultaneously opened in the Analyzer, the graph can display the
metadata from a single clip or from multiple clips. In this latter case, the each
clip's metadata curve is the color of the corresponding clip's timeline. . For
example, the data curve corresponding to the clip that has the yellow timeline is
displayed in yellow. In single clip mode, the user can switch between the
different graphs for each clip by selecting the clip in the Analyzer (usually done
by clicking directly on the targeted clip video).
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The  button switches between "superimposed" or "separate" mode when
multiple clip curves are displayed. This feature is only useful when graphs from
several clips are simultaneously displayed. In the "superimposed" mode, the
graphs of the different clips are superimposed on each other.

In the "separate" mode, the graphs are displayed as separate graphs, each in its
own display area.

The  button toggles between the "all clip" and "single clip" data stream browse
mode. These 2 modes alter the way data source streams are selected in the tree
view to the left of the graph.

The graph is fully synchronized with the timeline. So, if one of the clip is moved
on the left by dragging its timeline on the left (by click and dragging the yellow
timeline), the corresponding graph is also moved accordingly. The graph is also
zoomed in and out as the timeline is zoomed in and out.

8.4.2 Displaying Metadata on the Video

Proceed as previously explained for the InTheAction - Displaying Metadata in Live
Mode.

8.5 Using the Drawing Library

The Drawing library is a source for different collections of drawings that can be
displayed on video clips.  To use it, it must be enabled in the InTheAction
advanced Options. It is used to store and recall different sets of drawings which
can be used to assist with analysis and removes the need to redraw.  Strictly
speaking, the library is not linked to any metadata features but it can be used to
memorize the position of drawings that can be later linked to metadata streams.
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The Drawing Library allows the following features:

Define sets of drawings that are saved (persisted) between each session in
Dartfish Software - All the drawings in the Drawing Library are saved when the
user quits Dartfish Software. The next time the user launches Dartfish all the
drawings in the library are immediately available as soon as the InTheAction
module is enabled.
Switch between the different collections of drawings --- a collection of drawings
can be directly selected using the list box in the InTheAction left toolbar. It is
also possible to map a remote control key for switching between the different
groups of drawings. 
Manage the different groups of drawings by creating or deleting them. In  future
versions of Dartfish Software it will also be possible to export or import the
groups of drawings between different Dartfish computers.

The Drawing Library can contain up to 9 different templates. 

8.5.1 Managing Overlay Templates

The Drawing Library content is displayed by selecting the submenu item "Manage
Drawing Library" as follows:

The following dialog is then displayed:

All the currently available overlay templates are displayed in a list. The currently
displayed overlay template is marked with the red/yellow icon on its left side
("Overlay #1" in the example above). The name of each overlay template is
displayed in the "Name" column. With the current version of Dartfish Software, it is
not possible to rename an overlay template.
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Clicking the "New" button creates new empty overlay templates. At most 9 of
these overlay templates can be created. The name of the newly created overlay is
generated automatically.

Clicking the "Delete" button deletes the currently selected overlay template(s).
Multiple selection of overlay templates is possible using the usual methods
(clicking template names while combining shift and control keys).  The currently
displayed overlay template cannot be deleted.

8.5.2 Selecting the current Template

When the overlay template library is enabled (InTheAction Advanced Options), the
drawings that are displayed in InTheAction's Live mode are saved to the currently
selected overlay template.  This will be the template  indicated in a list box on the
left toolbar as shown below:

The currently selected overlay template can be changed by selecting an alternative
from the list box as follows:
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9 Dartfish Readers
Data Readers are used to link a video file to a data source file. Once linked, you'll be able to
synchronize the data stream s and video in the Analyzer and to view both simultaneously using
the Data Graph.  Drawing tools can be used to display data on the video image.

In earlier versions of Dartfish, the readers were available as add-in software to Dartfish Pro
editions. For version 6.1 and later readers will form part of the TeamPro Data edition of Dartfish.

There are two Data Readers available:

CSV Reader

Used to link video to character separated value (csv) files.  CSV files are commonly produced
or can be exported from a wide range of devices.

This reader can read many text file formats provided the following conditions are met:
 

1. The data can be separated (parsed) into columns which are delimited by a text character
(tab, comma, semi colon, space etc)

 

2. The resulting table has no more than one row of column headers.
 

Where condition 2 is not met, it is usually possible to open, parse and edit a text file in a
spreadsheet program such as Microsoft Excel.  By this method data can be rearranged and
extra headings removed.  The edited data should be saved as a .csv file rather than a
spreadsheet file.

Source name: This Reader names the source by the file name of the CSV file.  Optionally you
can input a source name of your choice.

Data streams: The CSV Reader parses character separated data into columns, each
of which represents a different data stream.  You are able to select which of
these columns you wish to link to Dartfish.

See linking CSV data

SRM Reader

Used to link video to .srm files created by SRM power cranks and training system. This includes
a Powermeter and a Powercontrol to record biodata held in SRM files (*.srm). Thanks to this
system, cyclists can record the power, the heart rate, the cadence, the speed and other data
deriving from them.

Source name: This Reader names the source by the initials of the person set in the
Powermeter and the date of the training.

Data streams: Five streams are fed:

Power developed on the crank in [watts] 

Cadence of the crank [rpm] 

Speed of the cycle [km/h] 

Heart rate of the athlete [bpm] 

Time of the day at which the training session happened [hh:mm:ss.xxxx]

See linking SRM data
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9.1 Linking CSV Data

You can create links between one video clip and more than one data source. To establish a link,
right-click a video file in the T ray or in the Item s List and select Link Data Streams from the
context menu. 

 

A Wizard first prompts you select a Reader from a list of installed readers.
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In the second step you will browse for the data file. 

A standard Open File... window pops up. Search for the Data Source file in your hard drive and
click Open.

In the next step you parse the Data Source and define how the Data Stream s are linked. 
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The information required here is explained in the following topics:

CSV document properties

Time Stamp

Selecting columns as Data Streams

Displaying data

After completing this step, the data source is linked and either additional data sources can be
linked or you can proceed to viewing and displaying the data with the video.

9.1.1 CSV document properties

In the Configuration step of the wizard you will define the parameters of the Data Source and
set which columns are to be linked as Data stream s.  The first part of the Configuration step
defines the properties of the Data Source.

 

Data Source name - This is the name used to identify the Data Source when using linked data in
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Dartfish or managing Data Sources etc.  By default the file name of the Data Source File is used
but you can enter your own name or select a name which combines the file name with the
current date.

Separator - It is essential that your data is successfully parsed before continuing.  To do this,
select the character used to delimit the columns of your Data Source.  A range of commonly
used separator characters is offered but it is also possible to type any character or combinations
of multiple characters.  If you are not sure which character has been used, experiment by
selecting different characters; when successful you will see your data divided into separate
columns as shown below:

 

 

Use first row as headers - where data has a header row you must tick this option to prevent
the headers being treated as data.  If your Data Source has more than one row of headers you
must delete or merge the extra rows.  You can do this by editing the file with text editor
software or a spreadsheet such as Microsoft Excel.

Hide comments starting with - the Data Source may contain text comments.  Often these are
marked by a specific delimiter.  Exclude such comments by typing the delimiter character used.

Manually set the file encoding - Dartfish automatically selects the file encoding used but if
necessary you can manually choose from a selection of text encoding types.

9.1.2 Time Stamp

The CSV reader must be able to relate each piece of data in a Data Stream to a position in the
video. There may be a column of time stamp data in the Data Source but where this is not the
case, a time stamp can be added at a fixed interval.

 

Using data from the Data Source as the time stamp 
 

 

1. Select the option "Data Source"  from the Select the tim e stam p source list box.
 

2. From the Select the tim e colum n list box, select the column from the Data Source that
contains time values.

 

3. Select the T im e Form at or units used.  It is essential that the reader understands how to
interpret time stamp data.  For example, if the time stamp is "100" does this represent 100
seconds or 100 milliseconds?

 

Using Interval or Frequency as the time stamp
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The reader can create a time stamp at a fixed interval (seconds or fractions of a second) or at a
fixed frequency (Hertz).  This is useful if time stamps do not exist in the data source or are not
in a time format recognisable by the reader.  The use Interval or Frequency time stamp sources, 
Data Stream samples must be at regular, fixed intervals.

9.1.3 Selecting columns as Data Streams

The Data Source may contain many columns of data that you will not wish to link to video.  You
must indicate those that you want to link by selecting them as shown below:
 

Distance and speed are the selected stream s

 

When you select a column, you will be prompted to set attributes for the data stream.
 

 

Name - This is the name used to identify the Data Stream when using linked data in Dartfish.  By
default the column heading from the data source is used but it can be changed to a value of your
choice.  In the example above "xdist [ m]" will be replaced by "Distance".  It is particularly
important to set a name property for the Data Stream when no meaningful header is present in
the Data Source
 

Type - Select either Number or Text.  By selecting "Text", numbers will be treated as text and
Dartfish will not attempt to plot them on the Data Graph. 

 

Unit name - This is a descriptor of the values of data in this data stream.  It is displayed in the
video clip Properties or in the External Data M anager.
 

After setting these attributes they can be changed by right-clicking the column heading.
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9.2 Linking SRM Data

You can create links between one video clip and more than one data source. To establish a link,
right-click a video file in the T ray or in the Item s List and select Link External Data from the
context menu. 

 

A Wizard first prompts you select the SRM Reader from a list of installed readers.

In the second step you will browse for the data file. 



169Dartfish Readers

© Dartfish. All rights reserved.- Version 7 -

A standard Open File... window pops up. Search for the data file in your hard drive and click Open.

Before completing the Wizard you have the option to link other files to act as Data Sources for
this video.

Displaying data

After completing this step, the data source is linked and either additional data sources can be
linked or you can proceed to viewing and displaying the data with the video.

9.3 Managing links

To manage links between video files and Data Sources, right click the video file in the Library.
Select M anage the data stream s... from the context menu.
 

Removing the link 
 

You can remove the link between the data source(s) and the video file. To do this, select the 
data source and click on the Unlink button. 

It is not possible to remove a single stream of a data source. 
 

Broken links

 A link can be broken when the external data source file has changed location on the disk or has
been renamed. It also happens when the video clip is shared and opened on a different machine.
As a result, the data cannot be displayed in the Analyzer any longer. 
 

To check for broken links right click the video file.  Select M anage the data stream s from the
context menu. Select the data source and its properties are visible on the right hand panel.  If the
link is broken the Availability property will read Source M issing.
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To correct a broken link, click the Relink button then browse for the new location of the data
source.  Synchronization of data and video is retained provided that the Dartclip metadata file
has also been moved to the new location of the video file (see Sharing Data for further
information about Dartclip files).

9.4 Viewing data

Dartfish's Analyzer M odule is capable of displaying Data Stream data in 2 ways:

1. Using the Data Graph panel each numerical data stream is represented as a different curve.
The data graph is also used to synchronize  the linked data with video.
 

The Data Graph and Graph drawings can only display integer and floating point numbers.  For
example, times in the format hh:mm:ss etc will be treated as text and cannot be displayed.  If
you wish to graph times (e.g. split times) then you must first edit the Data Source to represent
times as numbers.

More about the data graph and synchronization

1. Text drawings, graph drawings and other specialist data drawings can be linked to data
streams such that values can be displayed on the video image. Numerical data can be
displayed with the Text and the Graph drawing tools, while text can only be displayed with
the Text drawing tool. Below is an example of what it might look like. More about drawings
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9.4.1 Synchronization

You can quickly synchronize the data streams and the video in the Data Graph pane of the
Analyzer, as illustrated below:
 

To synchronize, proceed as follows:

1. Move to an appropriate position in the video clip.

2. Activate the synchronization mode by clicking on the Resynch button 
 

3. Align the streams to the playhead (green arrow in the illustration) by click & drag of the
streams to the left or to right.

 

4. Click a second time on the Resynch button once done.

To synchronize precisely, you should position the video to a distinct instant where you might
expect to see an obvious change in the data graph e.g. when the athlete starts pedaling. This can
be easily matched, for example, to the cadence stream (see illustration above).

9.4.2 Drawings

The data can be directly overlayed on the video image in the Analyzer. This is done by linking
drawings to data from a Data Stream.  The following is a representative but not comprehensive
list of drawing tools that can be linked to data.  Different devices will produce data which can be
best represented by different types of drawing:
 

Text tool:  Use to display any value from a Data Stream.  Using the Dartfish symbol font, the
text tool can also be used to display data specific icons to label values (see below).

 

Graph tool:  Use to represent numerical data as a graph.
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Force Meter:  Use to represent the magnitude and direction of a force (typically for devices
producing this type of data).  

 

To link a drawing to a data stream (example using T ext drawing):
 

1. Use the Text drawing tool to create a small text drawing.  The text you type to create the
drawing is not important e.g. "xxx".  Be sure to finish editing the text before proceeding to
the next step; to do this click on the video display outside the drawing.

 

2. Right click on the drawing to display the context menu.
 

 

3. Select the External Data Display... option.
 

4. Select the Data Source and Data Stream then click the OK button.
 

 

5. The text box now displays the value of the selected data stream.

Don't forget to synchronise to make sure the displayed values have proper meaning.

 

Displaying Dartfish explanatory symbols
 

The Dartf ish Readers provide the Dartf ish Sym bol font which you can use with the Text tool of
the Analyzer or In the Action modules.  Using this you can substitute long names with self-
descriptive symbols. See the Table 1 for the key mapping.

Key Symbol Description
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(character)

S or s Speed

P or p Power

C or c Cadence (pedals)

H or h Heart rate

The Dartf ish Sym bol font is automatically installed with Dartf ish software.

9.5 Sharing linked data

In order for others to see linked data you have two options:

1. You can publish a movie from the Analyzer.  This will include drawings that have been added
to the video clip - including those displaying Data Streams.

 

2. You can share the video f ile and the Data Source with other Dartfish users. Although the
recipient will need to re-establish the link using their own reader, synchronization is retained. 

9.5.1 Publishing video

You can publish the video with overlayed data from the Analyzer (see Saving movies from the
Analyzer to learn how to do this) as illustrated below:

 

In this case, the result is a video that can be shared in your team.  It does not require Dartfish to
play it. 

9.5.2 Sharing data

The Dartf ish Readers do not embed data in the video file (i.e. in the .dartclip file associated with
the video clip). They create a "live" link between the data and video files.  Therefore if you wish
to share video and linked data with other Dartfish users the following are required:

The recipient must have a Dartfish Software edition which includes the reader
 

You must provide the video clip, the Data Source file and (optionally) the Dartclip file as

shown below.
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The recipient establishes a link using the Relink function described in Managing links.

 

Dartclip files store all additions made to video by Dartfish.  These include details of external data
links and synchronisation.  If the Dartclip file has not been shared then the recipient must create a
new link between the video clip and Data Source.
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